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InterscopePlus Overview

Interscope was originally created in 1999 for the State Construction Office for internal use in
tracking projects as they moved through the office. In 2012, the decision was made to
incorporate the functionality of the University System’s “CAPSTAT” Capital Project Status
software into Interscope, and then further to create a state-wide Capital Project System that
would be used by the University System, Community College System, and all State Agencies.
InterscopePlus is now that system. Screen representations shown throughout this manual
currently reflect the Interscope system label, but will be subsequently modified to reflect the
new name.

InterscopePlus is designed to track the life cycle of Capital Projects from the time they are
authorized until they are closed out, including funding sources and HUB data. It is not intended
to be an accounting system.

Definitions and Terminology

Allocate: Designating funds from an authorization to a program. All funds must be allocated to
programs before the programs are active so that funds may be used for projects.

Amendment: A change to a design contract.

Assign: Designating funds from a program for use in a project. Funds must be assigned to a
project before they can be committed or obligated for contracts or other expenses.

Authorization: Approval by the relevant State governing body(ies) (legislature, OSBM, UNC
Board of Governors) or County to execute a project. It includes title, description/scope, amount,
funding type (general fund, non-general fund, state debt, non-state debt, R&R, R&R debt),
budget code, item, center, and date. Community Colleges may have authorizations approved by
the County. Authorizations may be allocated to one or more Programs.

Category: Project cost estimates are delineated by 4 categories: Design, Construction,
Contingency, and Other.

Design represents the estimated cost of the design contract

Construction represents the estimated cost of all construction contracts
Contingency represents the estimated cost of construction contingency

Other represents the estimated cost of project related or owner costs, such as soils
exploration, advertising, fixed furnishings and equipment (FF&E), etc.

Change Order: A change to a construction contract, either to the dollar amount, duration or
both.

Code: A 5 digit number that designates the funding authorization assigned by OSBM. The first
digit is a 4, which signifies capital project. The second and third digit represents the fiscal year
that the project is authorized (14 = 2014). The last two digits indicate the state agency or UNC
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institution. For Community Colleges that are authorized funding by the County a 5 digit number
that does not start with 4 will be used.

Commitment: A signed contract or Purchase Order for which the State or County is obligated to
pay the stated amount.

Estimated Cost: Total estimated cost of the project, broken down by category. Typically this
would come from the State Construction Office OC-25 form or, for Community Colleges the
NCCCS 3-1 Form.

Expenditure: A dollar amount that has actually been paid.
Fund Source: There are 6 different sources of funds defined:

General Fund: Appropriated funds

Non-General Fund: Receipts, grants, gifts, cash, County appropriated funds, etc.
State Debt: State Bonds, COPS, or Special Indebtedness

Non-State Debt: Bonds issued by Institutions, county, or self-liquidating funds
R&R: Funding for R&R from appropriations

R&R Debt: Funding for R&R from State Debt, such as Special Indebtedness or COPS.

HUB: Historically Underutilized Businesses, and commonly used to refer to Minority
Participation or Minority Business Enterprises (MBE).

Item: A 3-digit number assigned by OSBM in combination with the code to form a unique
identifier for an authorized capital project. Item numbers are assigned sequentially within each
fiscal year.

Milestone: Key date that is used to measure progress of a contract or project.

NCAS Center: A unique data item of up to 8 alphanumeric characters that identifies the financial
account in the North Carolina Accounting System (NCAS) related to a capital code-item.

Non-Code-Item Project: A project that does not have, nor require, a capital code-item
(<$300,000). These are typically small informal projects that are accomplished with local or
operating funds, but recording HUB participation is required.

Package: A “process container” for a construction project within the InterscopePlus system
which provides a place to record detailed information captured during design review, bidding,
award, and the construction administration phases of a construction project.

Primavera (P6): Statewide project scheduling system. Schedules are required for projects with
estimated costs over $500,000, based on Project Type.

Program: A collection of one or more projects closely related by initial authorization, by the
related nature of their execution, and/or having multiple funding sources for a single project.
The program serves as a “bucket” for funds from different authorizations that can then be
assigned to projects as needed. Program IDs are generated and assigned by the system.

Project: A project is typically any work requiring a design and construction contract, and may
involve construction or renovation of a single building or repairs to numerous buildings as
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authorized in “R&R” funding. Project IDs are generated and assigned by the system. Projects
must be created in the Program from which they will be funded.

Project Type: A designation based on agency/institution, dollar amount of project, funding
type, and other factors that determines what oversight role SCO will exercise, such as managing
design and construction contracts, reviews, etc. and the P6 schedule requirements. There are
different project types based on the department/agency, authorization, and dollar amount of
the project.

Special Project Designation: Classification of certain projects that are not given an OSBM code-
item and do not follow the typical financial controls. These include Guaranteed Energy Savings
Performance Contracts, Foundation Projects, Non-Code-Item Projects, and HUB only.

Users, Roles and Permissions

Every user must have a username and password. If you do not have one, refer to the State
Construction Office Website http://interscope2.doa.state.nc.us: /interscopeplus/logon.aspx
Download the appropriate form — Agencies; Universities; Designer/Contractors, for requesting a

logon.
InterSCOPE+
State Of North Carolina - Capital Project System

Interscope

I YRR
Iy RE ]
Iy RN D

Welcome to InterScope+

Version: 1.4_20160110

Please Logon
User Name: |

Password:

Download New Logon Request Form (Agencies)
Downioad New Logon Request Form (Universities)

Download New Logon Reguest Form (Community Colleges)

Designer and Contractor New Logon Reguests

Please enter your Username and Password.

CONTACT ADMINISTRATOR
Copyright ©® 2016
State of North Carolina :- State Construction Office
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A. New Account Instructions for Designers

Follow these steps for creating a new Designer user account:
1 — Select Designer in the User Type field. This will display the entry form.

2 —Complete the form for the fields indicated.

Note: It is important that the email address entered for the Firm be one that represents
the firm directly and is not necessarily defined for a particular individual since all
communication from InterscopePlus for this account will be sent to the email address
on file.

2 — Click Submit. A request will be sent to the InterscopePlus Administrator who will review your
request, verify the information against the data in InterscopePlus, activate your account and send
an email notifying you that the account has been activated.

Note: A user account cannot be established for any firm that does not have prior or current
approved and active construction projects setup in InterscopePlus.

6 [Rev. 7 —January 12, 2016]



InterscopePlus User Manual

InterSCOPE :: State Construction Office - Project Environment

New User Logon

UserType: O state Employee  Designer ' Contractor

Please select a user type from the options above.

Only State Agencies, Designers and Contractors

with existing contracts with the State of North Carolina can establish a
logon.

If your firm does not have a signed contract with the State of North
Carolina, your logon request may not be authorized.

To find out more about doing business with the State of North Carolina,
visit the State Construction Office website at: http:/'www.nc-sco.com

HUB Vendor: | Search VendorLink

Contact:

Design Firm | |

Addrass: | |

City & State | |

Phane l:l Example: (800) 555-1212

UserType: O ncBA O NCBELS © NCBOLA O Other

IMPORTANT: Each logon allows access to the projects contracted from one office.

If your company has multiple locations, please request a separate logon
for each location.

Enter the office/location for this logon.

CfficelLocation |
UserLevel: () pgpartment User ' Agency User
Department / Agency: | v |
Department / Agency: | v |

Are you a Capital Projects
Coordinator ?

romane [

Full Name |

Email |

Phaoneg | |E:-cample: (919) 807-4100

rosers |
Confirm Password l:l

Include any special instructions or comments reqarding your new account.

Comments:

All fields are required.

Help | First Time Users Piease see Help

CONTACT ADMINISTRATOR
Release: 6.8-201301004 Copyright @ 2014
State of North Carolina :: State Construction Office
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B. New Account Instructions for Contractors

Note: Any Contractor requesting to use InterscopePlus must first be registered with Vendor
Link, the Interactive Purchasing System. InterscopePlus uses Vendor Link to obtain verifiable
name and address information.

To register with Vendor Link, access the following URL and complete the Vendor Registration
process:

https://www.ips.state.nc.us/Vendor/VendorPubMain.aspx

Once you have received notification that your Vendor Link registration has been completed, you
may request a logon for InterscopePlus.

Follow these steps for creating a new Contractor user account:
1 — Select Contractor in the User Type field. This will display the entry form.
2 — Click on the Search VendorLink button. This will display the search page.

3 — Enter the first 3 letters of your company name and press Search. This will display search
results.

InterSCOPE = State Construction Office - Project Environment

HUB VendorLink Search

Enter the first 3 letters of your company name, then press[Search] to locate your Vendor Link record.

Contractor Mame: | |
[ Search ][ Cancel ]

Al fields are required.

4 — Find your company listing in the search results and press Select. This will fill in your company
information and return you to the account request form.

Inter SCOPE = State Construction Office - Project Environment

HUB VendorLink Search

Enter the first 3 letters of your company name, then press[Search] to locate your Vendor Link record.

Contractor Mame ‘GEHB |

[First/Prev] 1, 2, 3 [Next/Last]
Company Contact
Hame:  Jordan, Gene
Gene Jordan Appraizal Services Phons:  (319)221-23212 x
P.0. Box 14108 Fax  (313)231-4077
Raleigh, NC 27620 TollFres:
Email gensjerd@bellzouth.net
Hame:  Westman, Keith
General ASP : AppliTrack Phong: (B47)475-2283x 108
8001 Lincoln Avenue - Suite 704 Fax
Skokie, IL 60077 TollFree:
Email: keith@generalazp.com
Name: Ortega, Ana
General Biomedical Service, Inc Phone:  (504)£88-B557 x
1300 25th Strest Fax.  (300)S58-8449
Kenner, LA 70082 TollFree:
Email: info@generalbiomedical com
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5 — Complete the remaining fields on the form and press Submit.

Inter SCOPE = State Construction Office - Project Environment

New User Logon

User Type: O State Employee O Designer & Contractor

Username: |asystems

Full Mame: |Genera| Systems |

Email: |inf-J@genes-,—'stems.c-]m

Phone: |(919) 555-1212 | Example: (219) 807-4100

Confirm Password:

[ Submit H Cancel ][Help] Sirst Time Users Blease se

e eEls Fleaass o

Contact Administrator
Releass: §.5.1-20100228 Copyright ® 2009, 2010

State of Morth Carclina :: State Construction Cffics

Note: It is important that the email address entered for the Firm be one that represents the firm
directly and is not necessarily defined for a particular individual since all communication from
InterscopePlus for this account will be sent to the email address on file.

6 - Arequest will be sent to the InterscopePlus Administrator who will review your request, verify
the information against the data in InterscopePlus, activate your account and send an email
notifying you that the account has been activated.

Note: A user account cannot be established for any contractor that does not have prior or
current approved and active construction projects setup in InterscopePlus.

C. New Account Instructions for Owner Agencies

Follow these steps for creating a new Agency, Community College or University user account:
1 — At the logon screen, download the appropriate request form and completely fill it out.

2 — Each Agency and/or Department should have one person designated to review and approve
the requested roles/permissions.

Figure 7

When the InterscopePlus system administrator creates an SCO or Owner-Agency user, the user
is assigned one or more roles such as Project Manager, or Capital Project Coordinator (CPC), or
Financial Manager. Each role allows the user to access specific information and perform specific
actions within the system. The Menu options shown on the page header may vary based on the
Role or Roles assigned to the user. As an example, a Project Manager may be able to view
information only for projects within their agency or institution.
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Permissions are part of roles, and determine whether the Role can add, change, delete, or only
view the data on a given screen. The Project Manager role can allow the user to view the
funding sources for a project but not be able to change them, but the user can change Milestone
dates.

A user can have more than one Role, depending on their job requirements, and Roles can be
added or deleted as job requirements change. The System Administrator must make those
changes, based on requests from the appropriate management level.

This manual does not attempt to identify role requirements for each type of interaction.

3 — Once the completed form has been approved, submit to the System Administrator at
Interscope@doa.nc.gov.

4 — The administrator will notify the requestor when the user has been set up.
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V.

Navigation

A. Home

Each user has a home screen and will have tabs for ‘System Notices’ and ‘My Favorites’ that will
allow them to go directly to a program, project, or contract they want to work on. Depending
on your position or role, you may have additional clipboards such as ‘My Projects’, ‘Change
Orders in Progress’ or ‘Funds Transfers’'.

B. Searches

Much of the navigation in InterscopePlus is accomplished using Searches. You can enter as few
or as many criteria as you wish. The more criteria that are entered, the more specific the results
and so the shorter the list of returned data. It is possible to put in so many criteria that the
search will return O results. If this happens, try broadening the search criteria by removing
some. If changing search criteria, be sure to clear any unneeded items, or E=3. scroll to the
bottom of the results list and on the left side it will show how many pages of results there are.

Search results can be exported to Excel using the button in the lower right hand corner of
the screen.

C. Hyperlinks
Examples shown in this manual are basic navigation. Throughout the software there are
alternate ways of navigating, many of which utilize hyperlinks. These are shown in blue and are
intended to be short cuts to speed up navigation.
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V.  Entering Information

A. Hierarchy of Data
The data in Interscope follows the typical life cycle of a capital project. It starts with the authorization
and funding to do the project. The funding is allocated to a program, and the project is created in the
program. The project is designed and then constructed, and HUB is reported on the construction
contract. Data must be entered in order, i.e. a project must exist before you can enter a design contract
for it, etc.

Allocate Funds
| Program |
Project
m J' \Program #: 10114 - St. Construction - Minor Renovations
_Project #: 11026 - St. Construction - Enlarge conference room

Authorization

Design
Contract __Design #: 15-11026-01 - SCO Designer
l ~ _Package: 15-11026-01A - Enlarge conference room
/ Construction Contract #: 15-11026-01A-1 - SCO Contractor
Package
1 Construction Contract Detail Bid Items UB Participation

Construction
Contract

|

HUB

B. Authorization

Authorizations will typically be entered by a senior level person within a State Agency/
Department, by the System Office for Community Colleges or by UNC General Administration for
Universities. Your user profile, based on your login information, should autofill the Department.

From the Home screen, select Authorizations>Authorization.

m%é!ll InterSCOPE :: TRAINING SYSTEM USER: Mrfixit71 VIEW: State Construction

A} Home ¥ New (‘a FCAP (’: Design Review 5 Authorizations Q Programs Funds Change Request L8] My Account 7] Help
| -

New Projects | "i Authorization 2

System Notices My Favorites | Active Design Cc b _Authorization Item n Contracts | All Change Orders In Process | My Projects

This will bring up the Authorization Search screen. Select the “Add a New Authorization” button
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USER: Mrfixit71 VIEW: State Construction

Elm InterSCOPE :: TRAINING SYSTEM

ﬁ Home ¥ New E‘:\ FCAP (‘;*, Design Review $ Authorizations [::] Programs Funds Change Request LE| My Account @ Help

Authorization Search

Authorization Information Funding Information

Authorization ID: | = v Budget Code: | | jke v

Department: | = v Budget ltem: | jke v

—- Select Department -— v NCAS Center: | jke v

Institution/Agency: | - v | _ SelectAgency — ¥ Agency Funding Like v
Fiscal Year: | = v | —- Select Fiscal Year— ¥ Code:

Title: | Like v Total Authorized: - v

Available Funds: - v

Status: | - ¥ | SelectStatus —— ¥ Program: | |ike M

Legislative - v| Select— ¥

Authorization?

E3 £ 1 IR

Fill in the appropriate information. Required fields are marked with asterisks and have a red

border. Budget Iltem OR NCAS Center is required, but not both, however all three may be

| save
entered. Click on “'>= | Note that the Status is “Allocation in Progress”. This will not change

until all funds are allocated to programs.

NEW AUTHORIZATION:

Authorization

L2l Action | @cClose
HCS-&VG )

X Delete

Authorization Information

* Department: | Administration

Funding Information
* Budget Code: ‘41501

* Agency:| St Construction A Budget ltem:

* Fiscal Year:| 2015 - 2016 v

* Title: Minor Renovations

Status: Allocation in Progress

NCAS Center: ‘41’04

Agency Funding
Code:
* Authorized Date: [55,21/2015

Legislative Authorization: [«
Total Authorized: $0.00

* Authorized 5ma| Renovation projects
Purpose:
Is From Capstat: False

Once saved, the Authorization detail tabs show up on the lower part of the screen. There is also
a system assigned Authorization #. Select the ‘Authorization Item Detail’ tab and enter the
amount of the authorization in the proper fund source(s). When all fund sources have been

IH | save
entered, ok

13
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_Authorization #: 1041 - St. Construction - Minor Renovations

Authorization

1§
Authorization Information

* Department: | Administration

* Agency:| St Construction

* Fiscal Year:| 2015 - 2016

* Titlez[Minor Renovations

Status: Allocation in Progress

Legislative Authorization: (v

{” Comments

@ cClose

Action

Funding Information

* Budget Code: 41601 X
L

NCAS Center: 4704 |

Save

| Delete

Agency Funding |
Code:

* Authorized Date:

Total Authorized: $0 00

* Authorized
Purpose:
Is From Capstat: False

Small Renovation projects

Authorization ltem Summary Authorization ltem Detail

Source Orig. C-I-C Original Authorization
Amount
General Fund 41601-4T04 $
Non-General Fund 41601-4T04 s oog
Mon-State Debt 41601-4T04 $
R&R General Fund 41601-4T04 $
R&R State Debt 41601-4T04 s o0o0d
State Debt 41601-4T04 S

$0.00
$0.00
$0.00
$0.00
$0.00
$0.00

Program Allocation
Approved Changes

Audit Trail - Authorized | Audit Trail - Allocated Uploads

Pending Changes Proposed Current Allocated Assigned To Projects  Available To Assign
Authorization Amount Amount
$0.00 $ 750,000.00 $0.00 $0.00 $0.00
$0.00 $0.00 $0.00 $0.00 $0.00
$0.00 $0.00 $0.00 $0.00 $0.00
$0.00 $0.00 $0.00 $0.00 $0.00
$0.00 $0.00 $0.00 $0.00 $0.00
$0.00| $0.00 $0.00 $0.00| $0.00

You will need to create a program and allocate funds before the authorization will become

“Active” for use.

C. Creating a Program

At the top of your home page, select Programs>Program to bring up the Program Search Screen.

m—m InterSCOPE :: TRAINING SYSTEM

USER: Mrfixit71

VIEW: State Construction

ﬁ? Home =¥ New C*; FCAP C‘f; Design Review $ Authorizations E Programs Funds Change Request 83 My A
=" |

+

@ Help

Cost Estimate

}rs In Process My Projects

Fro >
J.’Lrogram

New Projects ’

System Notices My Favorites Active Design Contracts Active Cor+ ¥

TYPE »

4

0 found b
9/21/2015 8:23:00 InterscopePlus 1.3B_TRAIN Copyright @ 2015 - State of Nortl

AM Off »

b

4

i Delete?
_Project e

_Project (legacy funding only)
__Design Contract 5 B

| : State Construction Report a Problem
__ Package

Construction Contract

Change Order

If you are not sure if a Program already exists, perform a search for it by entering any search

criteria that might be applicable. If the Program does not exist, click

|Ad-::| @ New Program |

14
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Program Search

Department: - v Alternate Name: | | jke v

- Select Department -— v Budget Code: | | ke v

Institution/Agency: | = ¥ | - Select Agency — ¥ Budget Item: | | jke A

Fiscal Year: - ¥ | —— Select Fiscal Year — ¥ NCAS Center: | | jke A\

Program ID: ‘[ jke v Status: | = ¥ | Active v
Program Name: | ke v
Available to = v
Transfer:

eacr l vore ] ot | o iow Progn

The New Capital Program screen comes up. Enter the appropriate information. Required fields
are marked with asterisks and have a red border. The Program Name should be the same as the
Authorization Title. The Alternate Name is not required but it is for the local Agency/Institution

21 Action
. . = save
to use if they refer to the Program by a different name. Then
NEW CAPITAL PROGRAM:
Program
L2 Action | &cClose
N . wl Save
Department: | Administration v Program Name: \inor Renovations
* Agency: St Construction v Alternate Name:
* Fiscal Year:[ 2015 - 2016 v StelusZacive
Program ID: Remarks:

You should now see the Program Screen with the new Program # and tabs below it. The
Program # is generated by the system and cannot be changed.

Program added successfully.

Program #: 12153 - St. Construction - Minor Renovations

Program Program Funding Projects Assign Amounts to Projects Program Closeout
[ Action @ Close
* Department:| Administration v * Program Name: |\inor Renovations
* Agency:| St Construction v Alternate Name:
* Fiscal Year:| 2015 - 2016 v StakusHclive
Program ID: 12153 Remarks:

D. Allocating Funds

Funds are allocated from an Authorization to one or more Programs. If there are multiple fund
sources for an authorization, make sure that you select the one you want to allocate. You must
perform a separate allocation for each fund source to each Program.

NOTE: All funds must be allocated to change the Authorization status from ‘Allocation in
Progress’ to ‘Active’

Start by selecting Authorizations>Authorization.
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InterSCOPE :: TRAINING SYSTEM USER: Mrfixit71 VIEW: State Construction

fﬁ Home =¥New C‘s FCAP C‘s Design Review 5 Authorizations Ej Programs Funds Change Request 8 My Account L2} Help

New Projects Ii‘guthorization 2,

System Notices 1 My Favorites Active Design Co _ Authorization ltem n Con‘[ractsr |__All Change Orders In Process T My Proiectsr

This will bring you to the Search screen. Enter appropriate data and ——— for the
authorization.
Authorization Search
Authorization Information Funding Information
Authorization ID: = v ”:l Budget Code: | ke \ |
Department: \: v | Budget Item: | Like v |
Administration v NCAS Center: | | ke M
Institution/Agency: - \a - Agency Fundinc” Like v || |
St Construction v Code:
Fiscal Year: ‘ﬁl 2015 - 2016 v Total Authorized: | - v
B rer— Available Funds: | > A
Title: | Like v S
! Program: | | jke v

|
Status: | = ¥ | — Select Status — ¥ ‘ |

Legislative —
Authorization? = 7| —Select— ¥

m m Add a New Authorization

The search will return a list, below, of all Authorizations that meet the criteria. Select the
appropriate one by clicking on the ‘SELECT’, Auth ID or Code-Item-Center for that Authorization.

Authorization Search

Authorization Information Funding Information

Authorization ID: E”:l Budget Code: | Like v
Department: = v | Budget ltem: | | jke v
Administration v NCAS Center: |ike \

Institution/Agency: (= v | Agency Funding‘ ke v |

St. Construction v Code:
Fiscal Year: = v | 20152016 v Tota-l Authorized: | -~ vl
Title: ’lee:"| Available Funds: | > v |

| Program: | [ ke v
Status: | = v | — Select Status — ¥ ‘ |

Legislative —
Authorization? = 7|~ Select— ¥

m m Add a New Authorization

SL No. Auth ID Title Code-Item-Center Agency Funding Code Institution / Agency Auth Total Status -

1 ( SELEE 51[]41 ZMlnor Renovations (41601—4T04! St. Construction $750,000.00  Allocation in Progr ™
4 »
1 Authorization(s) found Export

That will bring you to the Authorization Information screen. Select the ‘Program Allocation’ tab,
then the ‘Add Allocation’.
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Authorization

W
Authorization Information

Eﬁ Action

&Close

Funding Information

* Department:| Administration

* Budget Code: 41601 |

* Agency:| St Construction

v | Budget ltem: | |

* Fiscal Year:| 2015 - 2016 v

NCAS Center: 4704 |

* Titlez Minor Renovations

Agency Funding| |

Status: Allocation in Progress

Legislative Authorization: (¢

" Comments

Code:

* Authorized Date:

Total Authorized: $750,000.00

* Authorized 5ma|| Renovation projects
Purpose:

Is From Capstat: False

Authorization Item Summary Authorization Item Detail ' Program Allocation Audit Trail - Authorized |~ Audit Trail - Allocated _| Uploads

Source Orig. C-I-C Cument Pending Available To Allocations
Authorization (Orig Changes Allocate
+ Appr Changes)

General Fund 41601-4T04 $ 750,000.00 $ 0.00 $ 750,000.0@ Add Allocation

Non-General |51 4704 $ 0.00 $ 0.00 $ 0.00

Fund

Non-State 16014704 $ 0.00 $ 0.00 $ 0.00

Debt

RE&R General |1 1501 4704 $ 0.00 $ 0.00 $ 0.00

Fund

RER State 115014704 $ 0.00 $ 0.00 $ 0.00

Debt

State Debt  41601-4T04 $ 0.00 $ 0.00 $ 0.00

otals $750,000.00 $0.00 $750,000.00

6 Authorization ltems found Add New Program

This will bring up a Program Search. Enter the appropriate information and

_Authorization #: 1041 - St. Construction - Minor Renovations

Authorization 0

* PROGRAM SEARCH _ BClose
~ Authorizati
Department: - v Alternate| ke v |
Administration Name: |
Institution/Agency: = v Budget Code: | ke v
St. Construction ‘ |
Fiscal Year: | - v | Budget Item: || o v |
2015 - 2016 v | -

Program ID: | | jke v
Program Name: | Like v |
Le ‘7 ‘
Available to | = v

Transfer:

NCAS Center: [ Lke ¥ |
\7 |
Status: = \a
Active v

From the search results, ‘Select’ the desired Program.
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_Authorization #: 1041 - St Construction - Minor Renovations

Authorizati

PROGRAM SEARCH
" @ Close
Authorizati
Department: = v Alternate | | ike v
Administration Name:
Institution/Agency: = v Budget Code: | | ke v
St. Construction v
Fiscal Year: | - v Budget Item: | ke v
2015 - 2016 v
Program ID: | Like ¥ NCAS Center: | |ike v
Program Name: | ke v
Le Status: | = v
Available to| - \ Active v
Transfer: :|
oore | e
SL No. Institution / Agency Program ID Program Name Alternate
el ! SELECT = st. Construction 10676 Museum of Natural Science Museum of Natural !
— 2 SELECT ), St. Construction 12153 Minor Renovations e
Authonzatig Uploads
This returns you to the Authorization Program Allocation screen with the selected program
displayed, ready for you to enter the appropriate dollar amount to be allocated.
_Authorization #: 1041 - St. Construction - Minor Renovations -~
Authorization
- tZiAction @Close
Authorization Information Funding Information
* Department: | Administration * Budget Code:[41601
* Agency:| St Construction v Budget Item:
* Fiscal Year:| 2015 - 2016 v NCAS Center: 4704
* Title:|Minor Renovations Agency Funding
Code:
Status: Allocation in Progress * Authorized Date: [gs,21 /201
Legislative Authorization: |«
Total Authorized: $750,000.00
* Authorized 5mall Renovation projects
Purpose:
Is From Capstat: False
Comments -
Authorization Item Summary Authorization Item Detail Program Allocation Audit Trail - Authorized Audit Trail - Allocated Uploads
Source Orig. CH-C Current Pending Available To Allocations
Authorization Changes Allocate
(Orig + Appr
Changes)
General 41601-4T04 | $ 750,000.00 $ 0.00 $ 750.000.00 Program Agency Program Name Original ~ Approved Pending Available to Assigned to
Fund : ’ ID Allocated  Changes  Changes Assign Projects.
Amount
St Minor =
12153 por @ $000  $000 $000  $0.00Delete
Construction  |Renovations
Allocation
Count: 1 o Allocate $750,000.00
Add Allocation
Non-
General 41601-4T04 $ 0.00 $ 0.00 $ 0.00
Fund
Non-Stale 16014704 $000 000 $ 0.00 -
Debt
4 »
| Action
i sae

Enter the amount to allocate to the Program and click on

Delete

. You will then see that the

funds are allocated, they are available to assign, and because all funds are now allocated, that

the Authorization Status is “Active”.
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Authorization update

Fund Allocations successful.

_Authorization #: 1041 - St. Construction - Minor Renovations
Authorization
Authorization Information

* Department:| Administration

* Agency: | St Construction

* Fiscal Year:| 2015 - 2016 M

* Titlez|Minor Renovations

Status: Active

Legislative Authorization: (¢

Comments

Authorization ltem Summary Authorization ltem Detail

Source Orig. C--C Current Pending Available To
Authorization Changes Allocate
(Orig + Appr
Changes)
General ~ 41601-4TD4 | § 750,000.00  $ 0.00 F’"’g’a“”‘gemy
Fund
12153 St
Construction
Allocation
Count: 1

Add Allocation

Creating a Project

Funding Information

* Authorized Date:

Program Allocation

successful.

L:ﬂ Action

@Close

* Budget Code:[41501
Budgettom |

NCAS Center: 4704 |

Agency Funding| |
Code:

Total Authorized: $750,000.00

* Authorized| small Renovation projects
Purpose:
Is From Capstat: False

Audit Trail - Authorized [ Audit Trail - Allocated | Uploads
Allocations
Program Name Original ~ Approved Pending  Available to Assigned to
Allocated  Changes  Changes Assign Projects
Amount
Minor 750,00 b $0.00 $0.00 $ 0.00 Delete
Renovations 750,000.00
To Allocate $0.00

NOTE: The Project must be created under the Program that will provide the funding for it.

Projects will be created by the Agency, Community College or University “Owner.”

At the top of your home page, select Programs>Program to bring up the Program Search Screen.

ﬂﬂ‘jm InterSCOPE :: TRAINING SYSTEM

USER: Mrfixit71

VIEW: State Construction

m Home ¥ New Cﬁ. FCAP Cﬁ. Design Review $ Authorizations E Programs Funds Change Request L'E] My Account @ Help
| S— |
W s ¥ | Cost Estimate
System Notices My Favorites Active Design Contracts Active Cer* b @;‘Ifam Iars In Process My Projects
TYPE » | Project Delete?
b _Project (legacy funding only)
0 found L ]
9/21/2015 90636 InterscopePlus 1 3B_TRAIN Copyright © 2015 - State of Nortl » | —Design Contract |~ State Construction
= o
b __ Package
b Construction Contract
b Change Order
Enter the appropriate information and =—.
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Program Search

Department: (= v | Alternate Name: |[ike v |
Administration v Budget Code: | | ke v
Institution/Agency: (= v | Budgetitem: || ke v |
St. Construction v NCAS Center: |Like v \
Fiscal Year: | = v | 2015-2016 v Status: = v |[ Active v
Program ID: | | ke v | |
Program Name: | Like v |
Available to| = v | |
Transfer:

m Add a New Program

The search results will show all Programs that meet your criteria.
want.

Program Search

‘Select’ the Program you

Department: ‘ﬁ| Alternate Name: | | ike v |
Administration v Budget Code: | |ike v |
Institution/Agency: E| Budget Item: | ke v |
St. Construction v NCAS Center: | [ike v |
Fiscal Year: | = v | 2015-2016 v Status: | = v | Active v
Program ID: | | ike v | | -
Program Name: | | ike v | \
Available to| - v | |
Transfer:
3
SL No. Institution / Agency Program ID Program Name Alternate Name Status
1 m St. Construction 10676 Museum of Natural Science Museum of Natural Science ACTIVE
2 @ St. Construction 12153 Minor Renovations ACTIVE

You will now be in the Program. Select the ‘Projects’ tab, then the ‘Add Project’ button.

Program #: 12153 - St. Construction - Minor Renovations

Program |~ Program Funding | Projects Assign Amounts to Projects Program Closeout

@ Close

SLNo.  Project ID Agency Project Code Project Title

Status

Estimated Cost Estimated

»

Total $0.00
0 Projects found

Now you are on the New Capital Project screen.

Add Project
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Program #: 12153 - St. Construction - Minor Renovations
NEW CAPITAL PROJECT:

Project

Project Information - Basic
* Program: 12153 - Minor Renovations
* Department: Administration
* Agency: St. Construction

Project ID: (Auto)

* Title: |

Description:

Agency Project Code:
Status: (Auto)

%2l Action & Close

Project Information - Advanced

® Standard Project
* Special Project () Performance Contract
Designation: Foundation Project
Non-Code-ltem Project

Fiscal Year Funded: | 2015- 2016 v

Bypass Financial Controls?

Estimated Cost

Estimated Project Cost: (Auto)
- Total Amount Assigned: (Auto)
= Estimated Need: (Auto)

Enter the Project Information — Basic, and Advanced as appropriate. Required fields are marked
with asterisks and have a red border. The Agency Project Code is optional.

1. Determining the Special Project Designation
In the Advanced block, select the appropriate type of project under Special Project

Description.

Standard Project: The default type that will apply to most Capital projects.

Performance Contract: This applies to Guaranteed Energy Savings Performance
Contracts

Foundation Projects: This applies primarily to UNC System projects that are
designed/constructed by a foundation but must be reviewed by SCO

Non-Code-ltem Projects: This is for projects that do not go through the normal State
authorization process, such as county funded projects at Community Colleges, or
projects completed with operating funds. This will also be used for reporting small
project HUB information. An Estimated Project Completion date, Funding Source,
Estimated Cost and Fiscal Year Funded must be entered. These fields appear for entry
only when the Non-Code-Item type is selected.

Disregarding Performance Contracts and Foundation Projects, the proper sequence for
determining what the project designation should be is:

Does it have a capital code-item funding source? If so, it will be a standard
project, regardless of cost estimate.
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If it doesn’t have a capital code-item funding source, then it belongs in a Non-
Code-Item Program.

If it will have a design contract or require any review by SCO (including
code only), regardless of cost estimate, it will be a Non-Code-Item
project.

If there will be no SCO review and no design contract, and it is being
entered only to meet the requirements for reporting HUB data, itis a
HUB only project.

Code- Designer
. ltem ALl Non-Code-ltem 9 HUB
Project , e or code
funding Program . Only
= review?
ource?

Non-Code-ltem Project
in Non-Code-ltem
Program

Standard Project in
Code-ltem Program

Fgfindation Project
on-Code-ltem Project

e

Standard Projects have financial controls, which require funds be assigned to the project
and commitments cannot exceed funds assigned. Non-Code-Item Projects do not have
financial controls and funds cannot be assigned to them.
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NOTE: Once you have selected the project designation and saved, it cannot be changed.
If it is the wrong designation, it will have to be deleted and re-entered with the proper

designation.

21 Action

Then .

Program #: 12153 - St. Construction - Minor Renovations
NEW CAPITAL PROJECT:

Project

Save

Project Information - Basic

* Program: 12153 - Minor Renovations
* Department: Administration
* Agency: St. Construction
Project ID: (Auto)
* Title:|Renovate lobby

Description: Reconfigure lobby and upgrade finishes

Agency Project Code:
Status: (Auto)

Project Information - Advanced
®

* Special Project Designation:

L2 Action | @cClose
A save

Standard Projet %! o
elete
Performance Ct
Foundation Project
Non-Code-ltem Project

Fiscal Year Funded: 20152016 v

Bypass Financial Controls?

Estimated Cost
Estimated Project Cost:
- Total Amount Assigned:
= Estimated Need:

(Auto)
(Auto)
(Auto)

After saving, the system assigns a project number and displays all of the respective Project tabs.

Project added successfully.

Program #: 12153 - St Construction - Minor Renovations
_Project #: 12285 )St. Construction - Renovate lobby
Project Cost Estimate Project Type Funds Assigned
Project Information - Basic

* Program: 12153 - Minor Renovations
Move to Another Program..

* Department: Administration
* Agency: St Construction
Project ID: 12285

* Title:|Renovate lobby

Description: | peconfigure lobby and upgrade finishes

Agency Project Code:
Status: Active

Financial Worksheet

* Special Project Designation:

Project Information - Advanced

Fiscal Year Funded: 2016

Bypass Financial Controls? No

Estimated Cost

Estimated Project Cost:

- Total Amount Assigned:

Contracts P6 Link

Milestones Closeout Project
2l Action @Close
®) Standard Project

Performance Contract

Foundation Project

Non-Code-Item Project
$0.00
$0.00
$0.00

= Estimated Need:
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F. Entering Cost Estimate

Cost Estimate, in terms of InterscopePlus, refers to the OC-25 for capital projects, or Form 3-1
for Community Colleges. If the OC-25 for the project has been certified by SCO, it will show on
the separate tab for the ‘Cost Estimate’. If the project name has been changed, the system may
not find the OC-25 and the ‘Search’ feature can be used to find it. If an OC-25 does not exist,
there is an option to create one. While an OC-25/Form 3-1 is required for the authorization of
particular types of projects, with some exceptions cited elsewhere in this manual, some type of
general cost estimate information is necessary to establish a project. General estimate
information is entered as part of the process of establishing the project type described in detail
in the next section.

Program #: 12153 - St. Construction - Minor Renovations
_Project #: 12285 - St. Construction - Renovate lobby

Project Cost Estimate Project Type Funds Assigned Financial Warksheet Contracts P6 Link Milestones Closeout Project

A Close

Associate Cost Estimate with this Project

Search.,

Cost Estimates associated with this Project

No Cost Estimates Found

G. Determining Project Type
Select the ‘Project Type’ tab.

Program #: 12153 - Si. Construction - Minor Renovations

_Project # 12285 - St. Construction - Renovate lobby

Project Cost Estimate Project Type Funds Assigned Financial Worksheet Contracts P6 Link Milestones Closeout Project
“Zl Action &Close
Attributes Determining Project Type:
Project Type
Institution and Cost
Project Type: Not Known
State Debt Override Project Type: No Override

State Land

Special Project Designation
Requirements of this Project Type:

Special Oversight P6 Schedule Requirement: Not Known
SCO Role: Not Known

Oversight Request N .
Milestones Required: Not Known

For help see: Project Types Table

Project Type State Construction
Manual

GS 143-129 GS 116-31-11 GS
116-40.6

GS 116-37 GS 115D-9

General Statutes:

Here you will enter information about the project which will be used to determine a Project
Type, which in turn determines SCQO’s oversight role, what type of P6 schedule will be required,
if any, and which milestones will be required. Click on the “Institution and Cost” section to start
the process.
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| e g v e
Program #: 12153 - St. Construction - Minor Renovations

_Project #: 12285 - St Construction - Renovate lobby

Project Cost Estimate | Project Type Funds Assigned Financial Worksheet | Contracts | P6 Link Milestones Closeout Project

2 Action @Close

Attributes Determining Project Type:

Project Type
Institution and Cost
Project Type: Not Known

Institution / Agency St. Construction Override Project Type: No Override

Estimated Project Costs:
Estimated Cost

Design Fee $: 0.00
Requirements of this Project Type:
Construction $: 0.00
. P6 Schedule Requirement: Not Known
Construction 0.0d
Contingency §: SCO Role: Not Known
Other §: 0.00
Milestones Required: Not Known
Total §: $0.00
For help see: Project Types Table

For State Agencies and Community Colleges, the Estimated Cost must be subdivided into 4
categories: Design Fee, Construction, Contingency, and Other.

For UNC Institutions, the Estimated Costs must be subdivided into the 4 categories for projects
estimated at more than $2M and so subject to SCO oversight. For projects estimated at less
than $2M, the estimate may be entered in the 4 categories, or as a lump sum cost by selecting
the appropriate radio button.

Program #: 11789 - UNC Pembroke - [45594-301] - Replace Boiler
Project #: 12283 - UNC Pembroke - Replace Dial Bldg. boiler

Closeout Project
Project Cost Estimate Project Type Funds Assigned Financial Worksheet Contracts P8 Link Milestones

"2 Action @Close

Attributes Determining Project Type:

Project Type
Institution and Cost
Project Type: Not Known

Institution / Agency UNC Pembroke Override Project Type: No Override
Estimated Project Costs:
Estimated Cost
Design Fee §: $0.00
Requirements of this Project Type:
Construction $: $0.00
O Enter Category Estimates . P6 Schedule Requirement:  Not Known
» fnter Total Estimates Consuckon $0.00
O " X 4
Contingency §: SCO Role: Not Known
Other §: $0.00 ~ R
Milestones Required: Not Known
Total $: 0.00
For help see: Project Types Table

Enter the cost estimate for the entire project, regardless of the amount of funding that is
available. For example, you may only have been authorized funding for advanced planning, but
you will enter the estimated cost for the entire project here.
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Program #: 12153 - St. Construction - Minor Renovations

_Project # 12285 - St. Construction - Renovate lobby

Project Cost Estimate | Project Type Funds Assigned Financial Worksheet | Contracts | P6 Link Milestones | Closeout Project

[ Action @ Close
Attributes Determining Project Type:

Project Type
Institution and Cost
Project Type: Not Known
Institution / Agency St. Construction Override Project Type: No Override

Estimated Project Costs:

Estimated Cost

Design Fee §: 10_1000 1]
Construction $: 100.000.00
. = P86 Schedule Requirement: Not Known
Construction 20000
i . z |
Contingency §$: SCO Role: Not Known

Other $:(_5.000.00)
: Milestones Required: Not Known

Total $:  $118,000.00

Requirements of this Project Type:

For help see: Proiect Tvpes Table
Click on each successive section under ‘Attributes Determining Project Type’ and complete the
required information:

State Debt would only be applicable if the funding was provided through State Debt (Bonds,
Certificates Of Participation (COPS), Special Indebtedness, or R&R-Debt).

State Land — This will be applicable to most projects except for Community Colleges and some
Foundation projects.

Program #: 12153 - St. Construction - Minor Renovations

_Project #: 12285 - St. Construction - Renovate lobby

Project Cost Estimate | Project Type Funds Assigned Financial Worksheet | Contracts | P6 Link Milestones | Closeout Project
L2 Action EClose
Attributes Determining Project Type:
Project Type
Institution and Cost
Project Type: Not Known
State Debt Override Project Type: No Override

State Land

7 This project will affect land owned or leased by the state of North

Carolina Requirements of this Project Type:

Special Project Designation — you already selected this when you created the project.

Special Oversight — This applies to a very limited number of projects, mainly DOT projects, that
have a requirement for concurrent Federal oversight.
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Program #: 12153 - St. Construction - Minor Renovations

_Project # 12285 - St. Construction - Renovate lobby

Project Cost Estimate | Project Type Funds Assigned Financial Worksheet | Contfracts | P6 Link Milestones | Closeout Project
"2 Action @Close
Attributes Determining Project Type:
Project Type
Institution and Cost
Project Type: Not Known

State Debt

State Land

Special Project Designation

Special Oversight

Override Project Type:

No Override

Requirements of this Project Type:

P6 Schedule Requirement: Nof Known
SCO Role: Not Known
Milestones Required: Not Known

Special Oversight: N/A v

Oversight Request — If the project would not require SCO oversight, but the Agency/Institution
would prefer SCO to have oversight, it can be requested here. An example is if the estimated
cost for a Community College project normally not subject to SCO oversight is $490,000, they

could request SCO treat it as if it were over $500,000.

Program #: 12153 - St. Construction - Minor Renovations

_Project #: 12285 - St. Construction - Renovate lobby

Project Cost Estimate | Project Type Funds Assigned

Attributes Determining Project Type:

Institution and Cost

State Debt

State Land

Special Project Designation
Special Oversight

Oversight Request

SCO Advisory Oversight Requested

Administer this project as if the est\mated$
cost were:

When all of the entries have been made, then ="

Financial Worksheet |

Contracts |-~ P8 Link Milestones |~ Closeout Project

@ Close

IjZ'I.m:tion

Project Type

Project Type: Not Known

Override Project Type: No Override

Requirements of this Project Type:

P6 Schedule Requirement: Not Known
SCO Role: Not Known
Milestones Required: Not Known

For help see: Project Types Table

Project Type State Construction

The Project Type is determined and

displayed along with the P6 Schedule Requirement, the SCO Role, and Milestones Required.
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Project Type update successful.
Program #: 12153 - St. Construction - Minor Renovations

_Project # 12285 - St. Construction - Renovate lobby

Project Cost Estimate | Project Type Funds Assigned Financial Worksheet | Confracts | P6 Link Milestones | Closeout Project
L Action @Close
Attributes Determining Project Type:
Project Type
Institution and Cost
Project Type: @3: Agency Project < $500K>
State Debt Override Project Type: No Override

State Land

Special Project Designation
Requirements of this Project Type:

Special Oversight P6 Schedule Requirement: Abbreviated

SCO Role: L - Limited SCO Oversight
‘Oversight Request N R
Milestones Required: P6 Abbreviated, SCO Full

| 8CO Advisory Oversight Requested
Administer this project as if the estimated g For help see: Project Types Table
cost were: Project Type State Construction
Manual
GS 143129 GS 116-31-11 GS
116-40.6
GS 116-37 GS 115D-9

General Statutes:

H. Assigning Funds

Note: Before assigning funds to a project, the project must exist and there must be funds
allocated to the program and available for assignment.

If there are multiple funding sources in a program, funds can be assigned to the project from
any available source. If multiple funding sources are to be used in a project, each respective
source to be used must be assigned to the project.

At the top of your home page, click on Programs>Program to bring up the Program Search
Screen.

m’-’m InterSCOPE :: TRAINING SYSTEM USER: Mrfixit71 VIEW: State Construction

s C

f’i‘} Home “¥New '4Fcap “4 Design Review $ Authorizations l: Programs Funds Change Request LE] My Account 17 Help
- &

New Projects ¥ | Cost Estimate

System Notices i My Favorites Active Design Contracts 1 Active Cor* b @bfﬂm }ers In Process » My Prmects'
TYPE Pl Project Delete?

14 _ Project (legacy funding only)

9/21/2015 G.06:36  InterscopeFlus 1.35_TRAIN Copyright © 2015 - State of Nortl # | —Design Contract | - State Construction

AM off Report a Problem
14 __ Package
14 Construction Contract
14 Change Order
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This will bring up a Program Search. Enter the appropriate information and click [eoarn] .

Program Search

Department: \ﬁ\ Alternate Name: | Like v
Administration v Budget Code: | Like v
Institution/Agency: I:v‘ Budget Item: | ke v
St Construction v NCAS Center:| Like \d
Fiscal Year:[= v | 2015.2016 v Status: | = v |[ Active v
Program ID: | ke v/ |
Program Name: | | jke v/ |
Available to| = v | |
Transfer:

m Add a New Program

The search results will show all Programs that meet your criteria. ‘Select’ to choose the Program
you want.

Program Search

Department: | = v | Alternate Name: | Like

v
Administration v Budget Code: | ke v
Institution/Agency: (= v | Budget Item: | Like v
St Construction v NCAS Center: | Like v
Fiscal Year: | = v | 2015-2016 v Status: | = v | Active v
Program ID: | ke v | |
Program Name: | | ke v | |
Available to | = v |
Transfer:
[oee |
SL No. Institution / Agency Program ID Program Name Alternate Name Status
1 m St. Construction 10676 Museum of Natural Science Museum of Natural Science ACTIVE
2 @ St, Construction 12153 Minor Renovations ACTIVE

This will bring you to the Program screen. Select the ‘Assign Amounts to Projects’ tab and click
on ‘Add Assignment’.

Program #: 12153 - St. Construction - Minor Renovations

Program Program Funding | Projects | Assign Amounts to Projects Program Closeout |
2l action Close
Assign Funds to Projects
Source Authorization Title Current C--C Original C--C Current Pending Proposed Assignments.
Allacation (Orig. ~ Changes Allocation
+ Appr.
Changes)
General Fund  Minor Renovations 41601-4T04  41601-4T04 $ 75000000  $ 0.00$ 750,000.00 Preiest!D ProjectName g@e“:' fesimnant Anout
rojec
Code
12282 Enlarge Conference Room $ 16,000.00 Delete|

0 Assign $734,000.00

$750,000.00 $0.00 $750,000.00

A new window will appear with a list of Projects in the Program. Click on the desired project and

then .
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Program #: 12153 - St. Construction - Minor Renovations

P Program | Program Funding ] : Projects ] Assign Amounts to Projects |- : Program Closeout l

1 Action . @Close

Assign Funds to Projects

Source Authorization Title Cument C1-C Original C-I-C Current Pending Proposed
SELECT PROJECT e assees

General Fund Department: Administration Agency Assignment Amount

Agency: St. Construction

i i 16,000.00/Delete
Program: 12153 - Minor Renovations AT

«Renovate lobby

1 Fund Assignment(s) found

Uploads ,Qnmmem&lﬁmgmm_ﬂ

o — [ soct | Cancel | | P

Action
. "I save —
Enter the amount of funds you want to assign and then
Program #: 12153 - St. Caonstruction - Minor Renovations
Program Program Funding | Projects | Assign Amounts to Projects Program Closeout |
2l Action | @cClose
Save
Assign Funds to Projects
Source Authorization Title Current C--C Original C--C Current Pending Proposed Assignments.
Allocation (Orig Changes Allocation
+Appr.
Changes)
General Fund  Minor Renovations 41601-4T04  41601-4T04 S 750,00000  $ 000/ 750,000 po| Froiect!D Project Name 'sfe"‘:’ Assignment Amount
ojec
Code
Enlarge Conference Room $
Renovate lobby. 3
$734,000.00
\Add Assignment
$750,000.00 $0.00 $750,000.00
1 Fund Assignment(s) found

Action
-g ave —
To Change an Assignment Amount, type in the new desired amount and L
To review the outcome of your action, you may click on the Project ID or Project Name and it
will take you to the Project. Select the ‘Funds Assigned’ tab and you can see the funds have
been assigned.

30 [Rev. 7 — January 12, 2016]



InterscopePlus User Manual

Program #: 12153 - St Construction - Minor Renovations

_Project #: 12285 - St. Construction - Renovate lobby

Project |~ Cost Estimate | Project Type | Funds Assigned Financial Worksheet | Contracts |~ P8 Link |~ Milestones |/~ Closeout Project
@ Close
Project Funds Assignment Summary Project #: 12285 - Renovate lobby
State Debt

ubtotal - State Debt $0.00

Non-State Debt
ubtotal - Non-State Debt $0.00

General Fund

Authorization Current C-I-C Orig. C-I-C

Minor Renovations 41601-4T04 41601-4T04

: = s )
ubtotal - General Fund $120,000.00)]

»

Non-General Fund

ubtotal - Non-General Fund $0.00

R&R State Debt
ubtotal - R&R State Debt $0.00

R&R General Fund

ubtotal - R&R General Fund $0.00
ofal Assigned $120,000.00|

Financial Worksheet

The financial worksheet provides information on the financial aspects of the project, including
such things as funds assigned, contractual commitments to design and construction. To access
this information, navigate to the Project, select the ‘Financial Worksheet’ tab and it will display
the ‘Estimated vs Committed’ tab.

Program #: 12153 - St. Construction - Minor Renovations

_Project # 12285 - St Construction - Renovate lobby

Project |~ Cost Estimate | Project Type |~ Funds Assigned Financial Worksheet ~~ Contracts |~ P6 Link | Milestones Closeout Project |

Estimated vs Committed Contingency | Expenditures - Design [ Expenditures - Construction | 4 Expenditures - Other |

&Close

Worksheet Summary
Assigned Funds: $120,000.00 Assigned Funds: $120,000.00

Total Estimated Cost: $118,000.00 Total Committed:

Estimated Surplus (Need): $2,000.00 Available to Commit: $120,000.00
Assign Funds
Worksheet Detail
Committed
Estimated Cost @riginal Contracts Revised Conlracts Expegided

Design Fee $ s $ 0.00 $ 0.00 $ 000
Construction $: S $ 0.00 $ 0.00 $ 0.00
Contingency $: S

Other § $ $ 0.00 $ 0.00 $ 0.00

$118,000.00
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The Assigned Funds are automatically displayed, based on the total amount of funds assigned
from the Program, regardless of funding source. Details can be viewed on the ‘Funds Assigned’
tab.

The Estimated Cost data is automatically displayed from the data entered in the ‘Project Type’>
‘Estimated Costs’ tab. These costs can be changed by selecting the appropriate cost category and
entering a new number in the field. If the project type has not been established, Estimated Cost
information may be entered here.

The Total Committed is the sum of all commitments (design contracts, construction contracts and
any Purchase Orders). The amounts of the design contract and construction contract are
automatically shown when the respective contract is executed. Changes to those contracts are
shown in the Revised Contracts column and the total of the Revised Contracts will become the
total committed. Refer to sections on creating design contracts, creating construction contracts,
and change orders for details.

The system will allow the Estimated Cost to be greater or less than the Assigned Funds, but it will
not allow Total Committed funds to be greater than Assigned Funds for Standard Projects. Simply
put, you cannot contract for any work without having sufficient funds available.

Other S would be other owner related costs that would appropriately be charged to the project
such as advertising, soils exploration, fixed furnishings and equipment (FF&E), etc. Refer to the
section on entering Other Commitments for detailed instructions.

Contingency S are assumed to be the construction contingency. For projects with design contracts
under negotiation, the amount listed as the estimated contingency will automatically be shown
as construction contingency when the design contract is established. This may be modified in the
design contract negotiation process and revised as appropriate.

J. Creating a Design Contract

For projects that have full SCO oversight, SCO will enter the design contract. This section is
intended for non-SCO users to enter University “download,” Community College, or any
informal project design contracts.

Navigate to the Project for which the contract will be created. Select the ‘Contracts’ tab, then
the ‘Add Design Contract.’

Program #: 12153 - St. Construction - Minor Renovations
_Project #: 12285 - St. Construction - Renovate lobby
Project Cost Estimate Project Type Funds Assigned Financial Worksheet Contracts P6 Link Milestones Closeout Project

& cClose

SCO ID# FIRM STATUS PHASE TYPE OVERSIGHT CONT]|

»

0 found Add Design Contract
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This brings up a Select Designer window. Enter the appropriate information to retrieve the

desired designer, then . Select the designer.

Select Designer...

Li s e '] Volul:;i::, vl |(999-999-
[Like v |[SCO Fax#: ke v (999-999-
| Like 9999)

Website URL: | Like v

Year| = v
Established:

Parent: Like v

Parent Branch: -
Former Name: | | ke v

D:[Like v ]

LastUpdate: = v || , ,  [@

Select Designer...

E

Status:

Contact
Person:

Tsl5[E 166 51" 5[5

Parent: [ ke v

|

Parent Branch: | = v _Seleci— ¥
Former Name: | |ike v

D:(lke v

Last Update:

951952316
951952012
951951696
951952491
951951393
951952348
951952590
951952986

PEIIEERRGE

18 found
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This will bring up the ‘Detail’ tab, autofills the designer information, , fills in the Financial
Worksheet Summary and the Target Contract amounts from the Project, as shown below.

Program #: 12153 - St. Construction - Minor Renovations

_Project #: 12285 - St. Construction - Renovate lobby
NEW DESIGN:

Detail

Contract# (Auto)
* Contract ID: (Auto)
SCO Oversight: L - Limited SCO Oversight

* SCO Plan Review: | Limited Oversight ¥

Scope of Limited
Oversight:

Contract Type:| Standard Design Contract (Fully Func ¥

Contract Status: | Creating A

Designer
Name: SCO Designer |_j

Address: 301 N. Wilmington Street
Surte 450
Raleigh, NC 27601
License#: 123456789
HUB Firm: Not a HUB

Change Designer

Dates

Selection: /
RFP Letter: /

Agreement: /

Signed By| /
Designer:

Signed By| /
Agency:

sco|
Acceptance:

E B EE EE
U

©

Financial Worksheet Summary

Estimated:
Assigned Funds:
Estimated Cost:

Estimated Surplus
(Need):

Actual:
Assigned Funds:
Total Committed:

Available to
Commit:

$120,000
$118,000

$2,000

$120,000
$0

$120,000

"2 Action 3 Close

Design Contract Fees and Funds

ORIGINAL DESIGN CONTRACT:

Construction Target $: 100000.00 @
Contingency Reserve Target 3000.00 @
$:

Original Design Fee $: 10000.00 @

CURRENT DESIGN CONTRACT:

Construction Target: $100,000@)
Contingency Reserve Target: §3,000 9
Design Fee: $10,000@)
Proposed Commitment Amt $10,000.00

$:

For the SCO Plan Review there are two options — Limited Oversight or Code Only. The Limited
Oversight option requires that you show the Oversight requirements in the box. If there will
only be review of plans, select Code Only.

Select the appropriate Contract Type.
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Program #: 12153 - St. Construction - Minor Renovations

_Project #: 12285 - St. Construction - Renovate lobby

NEW DESIGN:
Detail
L2 Action ¢ Close
Contract# (Auto) Dates Design Contract Fees and Funds
* Contract ID: (Auto) Selection:| / / (=) @
SCO Oversight: L - Limited SCO Oversight RFP Letter:| , / E @ CRILEL B e
* 8CO Plan Review: | Limited Oversight ¥ Agreement:| / / = ?) Construction Target $: 100000.00 @
Scope of Limited|pesign Review Only SignedBy| / / Eg Contingency Reserve Target 3000.00 @
Oversight: Designer: g §:
SignedBy| / / =) 2 Original Design Fee $: 10000.00 @
Contract T!"Pe:l Standard Design Contract (Fully Func ¥ Agegg’; &
/s [E]
Standard Design Contract (Advance Planning Only) ! @ .
[ TN Standard Design Contract (Fully Funded) tance: CURRENT DESIGN CONTRACT:
Letter Agreement (General Use)
i 5 $100,000
Letter Agreement (Programming) Construction Target: 0008
Letter Agreement (Commissioning) Contingency Reserve Target: $3,000 @)
Letter Agreement (Sustainable Energy Proagramming)
Not Applicable Design Fee: $10,000@

+ weanCial Worksheet Summary

There are several Contract Types to choose from and it is important to pick the correct one.

Standard Design Contract (Fully Funded): Typical design contract where all funds are
available at the time of execution and contract is the full State standard design
agreement.

Standard Design Contract (Advanced Planning Only): This would apply where the
design contract amount is negotiated but only a portion is funded. Examples include
funding through DD development or through full design but without construction
administration (CA) funding availability. Contract is the full State standard design
agreement.

Letter Agreement (General Use): A design agreement using the letter agreement format
with the work as described in the agreement. Examples include feasibility studies or
work under an open-end design arrangement using a letter agreement.

Letter Agreement (Programming): Contract for programming using the letter
agreement format and as described in the agreement.

Letter Agreement (Commissioning): Contract for commissioning using the letter
agreement format and as described in the agreement.

Letter Agreement (Sustainable Energy Programming): Contract for energy modeling
using the letter agreement format and as described in the agreement.

Not Applicable: This would apply to projects where there is no design contract or code
review, such as HUB Only.

Change the Construction Target S, Contingency Reserve Target S, and/or the Original Design Fee
S as necessary. Note that the target construction amount is assumed to be the construction
budget estimate. If the design agreement should reflect a different amount, for example if you
want to design to 85 or 90% of the construction budget during periods of rapidly escalating
prices, change the target amount.

If the project is funded for Advanced Planning Only and Standard Design Contract (Advanced
Planning Only) is selected as the Contract Type, and funds are limited, check the box for Limit
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Design Fee Commitment to the following amount and insert the proper dollar amount.

NEW DESIGN:
Detail
[ ction EClose
Contract# (Auto) Dates Design Contract Fees and Funds
* Contract ID: (Auto) Selection:| / / Bea
~  ORIGINAL DESIGN CONTRACT:
SCOR - Review Only RFP Letter: / @
Oversight: - :
* SCO PlanCode Only Agreement: | / / @] @ Construction Target $: 1,542,043/ @
Review: SignedBy| , @ Y Contingency Reserve 46261 @
Designer: ¥ Target§: X
SignedBy| / / [E] g Original Design Fee §: 154,204/ @
Agency: =
Contract Type:| Standard Design Contract (Advance P ¥ sco
Acceptance: ~  CURRENT DESIGN CONTRACT:
Contract| Creating v )
Status: Construction Target: $1,542,043 @
Contingency Reserve $46,261 @)
Target:
Financial Worksheet Design Fee: I |
Summary
Designey Estimated:
Name: SCO Designer [ 3 Limit Design Fee 110,000.00)
Assigned Funds: CETATT Comm_ltment to the
Address: 301 N. Wilmington Street ¥ following amount:
e Estimated Cost: 51,700,000 e $110,000
Estimated [ueE
Raleigh, NC 27601 Surplus (Need): -$1,640,000
License#: 123456789 Actual:
HUB Firm: Not a HUB Assigned Funds: $150.000
Change Designer Total Committed: $0
Available to $150.000
Commit:
Worksheet Detail

The financial controls will not allow a commitment greater than the funds Available to Commit.

= save
You can “™*  atany time.

Enter the Selection Date, RFP Letter Date if applicable, Agreement date if agreement has been

H Save

A1 Delete

reached and This will automatically update the Contract Status to “Created — Not
Signed” and show the proposed commitment.
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Contract Status changed to Created - Not Signed

Click: ACTION->SAVE to save this change.

Program #: 12153 - St. Construction - Minar Renovations

_Project #: 12285 - St. Construction - Renovate lobby

NEW DESIGN:
Detail

Contract# (Auto)
* Contract ID: (Auto)

SCO Oversight: L - Limited SCO Oversight

* SCO Plan Review: | Limited Oversight ¥

Scope of Limited pesign Review Only

Dates

Selection: 01/13/2015
RFP Letter: 01/20/2015
Agreement: 01/23/2015

SignedBy , /

Oversight: Designer:
SignedBy / /

Contract Type: | Standard Design Contract (Fully Func ¥ Agency:
scol ;

Contract Status: 7(m Acceptance:

Designer
Name: SCO Designer _j

Address: 301 N. Wilmington Street

Suite 450

Raleigh, NC 27601
License#: 123456789
HUB Firm: Not a HUB

Eg
Ee
Ee
@@‘,
Eg
Eg

Financial Worksheet Summary

Estimated:
Assigned Funds:
Estimated Cost:

Estimated Surplus
(Need):

Actual:
Assigned Funds:
Total Committed:

Available to
Commit:

$120,000
$118,000

$2,000

$120,000
$0

$120,000

Z Action @Close

Design Contract Fees and Funds

ORIGINAL DESIGN CONTRACT:

Construction Target $: 10000000 @
Contingency Reserve Target 3000.00 @
$:

Original Design Fee $: 10000.00 @

CURRENT DESIGN CONTRACT:

Construction Target: $100,000@
Contingency Reserve Target: $3,000 9
Design Fee: $10,000 @
Proposed Commitment Amt $10,000.00

$:

When the Signed by Designer and Signed by Agency dates are entered and saved, the Contract
Status will be changed to “Active.” Once the Contract Status is “Active”, the screen will show
the CURRENT DESIGN CONTRACT information and the updated commitment in the Financial

Worksheet Summary.

|4 Action

I save
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DesignContract added successfully.
Program #: 12163 - St. Construction - Minor Renovations
_Project #: 12285 - St. Construction - Renovate lobby
__ Design #: 16-12285-01 - SCO Designer

Detail Contract Scope and Fees Breakdowns Amendments Consultants Packages
W L2l Action Close
Contract# 1 Dates Design Contract Fees and Funds
* Contract ID: 16-12285-01 Selection: 2015-01-13 g5
@
ORIGINAL DESIGN CONTRACT:
SCO Oversight: L - Limited SCO Oversight RFP Letter: 2015-01-20 )
* $CO Plan Review: | Limited Oversight ¥ Agreement: 2015-01-29 g Construction Target $: 100,000 &)
Scope of Limited gsign Review Only Signed By 2015-02-10 ¢ Contingency Reserve Target $: 3,000 @
Oversight: Designer: = . X 10.000 &)
Signed By 2015-02-12 ¢ Original Design Fee $: 000 @
Contract Type:| Standard Design Contract (Fully Func ¥ Agency: -
SCO Acceptance: 2015-02-13 © CURRENT DESIGN CONTRACT:
Contract status v '
Construction Target: $100,000@
Contingency Reserve Target: $3.000@
Design Fee: $10,000@
Financial Worksheet Summary
f Estimated:
Designer e
g . . @ctual Commitment Amt $: $10,000 DD)
Name: SCO Designer [ Assigned Funds: $120,000
Address: 301 N. Wilmington Street Estimated Cost: $118,000
Suite 450 Estimated Surplus $2.000
(Need): '
Raleigh, NC 27601
Actual:
License#: 123456789
Assigned Funds:
HUB Firm: Not a HUB ¢ SEIT
Total Committed:
Available to $110,000
Commit:

Corrections or edits may be made, but require that the contract status be changed to “Creating”

Action

in order to open fields for editing, then changed back to “Active” and "
If this is an in-house design, a design contract is still required. Select ‘In-House Design by’ for
your agency from the Designer selection list and create a contract with SO and fill in the
appropriate dates.

K. Entering Design Amendment

For projects that have full SCO oversight, SCO will enter the desigh amendments. This section is
intended for non-SCO users to enter University “download,” Community College, or any
informal project design contract amendments.

Navigate to the design contract, select the ‘Amendments’ tab, and click on ‘Add Amendment’.

Program #: 12153 - St. Construction - Minor Renovations
_Project #: 12285 - St Consfruction - Renovate lobby
__Design #: 16-12285-01 - SCO Designer

Detail Contract Scope and Fees Breakdowns Amendments Consultants Packages

Close

DESCRIPTION $DESIGN FEE $CONSTRUCTION $CONTINGENCY AMENDMENT DATE SIGNE|

0 found Add Amendment
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It shows the Current contract amount, the Financial Worksheet Summary, Amendment Fees and
Funds and Amendment Dates. Enter only the changes to the Fees and Target Funds necessary
for this amendment. These changes will be added to the existing contract. A description of the

Action
. . . ) save
amendment is required. Enter the appropriate dates and
Amendment added successfully.
Program #: 12153 - St. Construction - Minor Renovations
_Project #: 12285 - St Construction - Renovate lobby
_ Design #: 16-12285-01 - SCO Designer
___Amendment #1
Amendment
2 Action EClose
Current Design Contract Financial Worksheet Summary Amendment Fees and Funds
Estimated: -
Construction Target: $100,000 Change to CO"S_F::;;':S'_' 0
Assigned Funds: |
Contingency Target: $3,000 J $120,000 Change to Contingency g
. Estimated Cost: $118,000 Target$:
Current Design Fee: $10,500 . Change to Design Fee $:
Estimated Surplus (Need): $2.000
Actual:
Assigned Funds: $120,000
Total Committed: $10,500
Available to Commit: $109,500
Worksheet Detail
Amendment Dates Description

Add 3D rendering of new lobby
Amendment Date: |

Signed By Designer:
Signed By Agency: |¢
SCO Receipt: [03/11/2015

| _Generate Amendment (MS Word) |

@ gnd it takes you back to the ‘Contract Amendments’ tab and shows you the results of
the amendment.

Program #: 12153 - St. Construction - Minor Renovations
_Project # 12285 - St Consirucfion - Renovate lobby
__Design #: 16-12285-01 - SCO Designer

Detail Contract Scope and Fees Breakdowns Amendments Consultants Packages
Close
# DESCRIPTION $DESIGN FEE $CONSTRUCTION $CONTINGENCY AMENDMENT DATE sl
1 Add 3D rendering of new lobby 500.00 0.00 0.00 2015-03-09

1 found Add Amendment Export

On the ‘Detail’ tab, it shows the updated Current Design Contract Design Fee and updated Total
Committed.
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Program #: 12153 - St. Construction - Minor Renovations
_Project #: 12285 - St Construction - Renovate lobby
__Design #: 16-12285-01 - SCO Designer

Detail Contract Scope and Fees Breakdowns | Amendments Consultants Packages |
W " Action EClose
Contract# 1 Dates Design Contract Fees and Funds
* Contract ID: 16-12285-01 Selection: 2015-01-13 )
ORIGINAL DESIGN CONTRACT:
SCO Oversight: L - Limited SCO Oversight RFP Letter: 2015-01-20 7]
* SCO Plan Review: | Limited Oversight ¥ Agreement: 2015-01-20 g Construction Target $: 100,000 &
Scope of Limited | pasign Review Only Signed By 2015-02-10 & Contingency Reserve Target $: 3,000 @
Oversight: Designer: - . . 10,000 &
Signed By 2015-02-12 ) Original Design Fee $: £ Q9
Contract Type:| Standard Design Contract (Fully Func ¥ Agency:
SCO Acceptance: 2015-02-13 (7]
hd CURRENT DESIGN CONTRACT:
Contract Status:| Actjye v
Construction Target: $100,000@
Contingency Reserve Target: $3,000 @
- = Design Fee: ..$1D,SUD 7
Financial Worksheet Summary
f Estimated:
Designer SL=h -
) Actual Commitment Amt $: $10,500.00
Name: SCO Designer [ Assigned Funds: $120,000 ctual Commitment Amt § -
Address: 301 N. Wilmington Street Estimated Cost: $118,000
Suite 450 Estimated Surplus? $2.000
(Need):
Raleigh, NC 27601
Actual:
License#: 123456789
Assigned Funds:
HUB Firm: Not a HUB ¢ 2120000
Total Committed:
Available to
Commit: SET

And on the ‘Project Financial Worksheet’ it shows the Revised Contracts amount.

Program #: 12153 - St. Construction - Minor Renovations

_Project #: 12285 - St. Construction - Renovate lobby

Project Cost Estimate | Project Type | Funds Assigned Financial Worksheet Contracts P6 Link | Milestones Closeout Project |
Estimated vs Committed Contingency | Expenditures - Design | Expenditures - Construction Expenditures - Other |
@Close
Worksheet Summary
Assigned Funds: $120,000.00 Assigned Funds: $120,000.00
Total Estimated Cost: $118,000.00 Total Committed: $10,500.00
Estimated Surplus (Need): $2,000.00 Available to Commit: $109,500.00

Assign Funds
Worksheet Detail

Committed
Estimated Cost Original Contracts Revised Contracts Expended
Design Fee $ s [ 1000000 $ 10,000.00 $ 0.00
Construction §: $ | 100,000.00 $ 0.00 $ 0.00 $ 0.00
Contingency $: 3 3,000.00
Other § 3 5,000.00 $ 0.00 $ 0.00 $ 000

$118,000.00 $10,500.00

L. Creating a Construction Contract

For projects that have full SCO oversight, SCO will enter the construction contract. This section
is intended for non-SCO users to enter University “download,” Community College, or any
informal project construction contracts.
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Within the InterscopePlus system, design contracts typically yield documents that require
reviews at different stages of design. At the end of the design process, there is a construction
contract, and therefore the construction contract is linked to a design contract. The item that
connects the design contract and the construction contract is called a Package, and it is primarily
how SCO tracks the design review process.

To create a construction contract, navigate to the appropriate design contract, select the
‘Packages’ tab and select the correct package. Normally there is only one package.
Program #: 12153 - St. Construction - Minor Renovations

_Project #: 12285 - St. Construction - Renovate lobby
_ Design #: 16-12285-01 - SCO Designer

Detail Contract Scope and Fees Breakdowns Amendments Consultants Packages
Close
SCO ID# PACKAGE_TITLE STATUS PROJECT MONITOR % COMPLETE TOTAL CONTRACTS PLAN LOCATION
(16-12285-01A ) Renovate lobby Under Design Unassigned
1 found New Package Export

You will need to update the Bidding/Construction Contracts information on the ‘Detail’ tab by
indicating whether it is a formal contract and the construction procurement type of contract
(Single Prime, Construction Manager at Risk, etc.) from the drop down lists. Entering other

. . . . . =l save
information or updating status is optional. Then
Program #: 12153 - St. Construction - Minor Renovations
_Project #: 12285 - St. Construction - Renovate lobby
__ Design #: 16-12285-01 - SCO Designer
__ Package: 16-12285-01A - Renovate lobby
Electrical Certificates |~ Construction Closeout
Detail SCHEDULE - Planned and Actual Plan Reviews Construction Contracts Monthly Progress. Weekly Inspection
[l Action @ Close
Package A Bidding/Construction Contracts
Oversight: L - Limited SCO Oversight Approved for Form@
* Title: Renovate lobby id: Contracts?
Approved for * Award Type:@ngle Prime 2 v
* Type:| Undstermined v Award:
* status:| Under Design v Construction Administration Fees / Funds
Status
Reason: * Project| Unassigned ¥ Liquidated
Fos:;ar:- g Monitor: Damages 0.00
LEE Monthly (/day):
Loca:i’clianr! Conference: CD Cost 000
. Percent o, & Estimate:
* Complete:  ~ Plan Deposit: 000
County:| UNKNOWN v Total Change $000
Renovate lobby Final Punchlist:| Active v Orders:
" Total
Construction $0.00
Description: - - Cantrant:
Description b rehive Information
Designer Archive| /, / =
Rep: Date:
Archive
Box#:
Micro
Film#:

Select the ‘Construction Contracts’ tab and then ‘New Construction Contract’.
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Program #: 12153 - St. Construction - Minor Renovations
_Project #: 12285 - St. Consfruction - Renovate lobby
__Design #: 16-12285-01 - SCO Designer

__ Package: 16-12285-01A - Renovate lobby

Electrical Certificates Construction Closeout
Detail SCHEDULE - Planned and Actual Plan Reviews Construction Contracts Monthly Progress Weekly Inspection
& Close
CONTRACT# CONTRACTOR TYPE STATUS $ORIGINAL $CURRENT ORIG DAYS

3

0 found New Construction Contract

The Select Contractor window will appear. Enter criteria needed to find the correct contractor,
and select the contractor from the search results.

Program #: 12153 - St. Construction - Minor Renovations
_Project #: 12285 - St Construction - Renovate lobby
__ Design #: 16-12285-01 - SCO Designer
__ Package: 16-12285-01A - Renovate lobby
NEW CONSTRUCTION CONTRACT:

Constructi
Select Contractor... @ Close
Contract S Name: Email:
Forl HUB Certified? __Select— v
*Comr Contact Person: Address: @
Contr
Stat City: State: @
* contr Zip: Phone: (999-999-9999)
Ty | Ee
Bid Numk Company City, State Voice Contact Email
Final Chal SELECT WYSCO CONTRACTORS, INC. MOREHEAD CITY 252-726-8437
Appg SELECT Juan Francisco Cuellar Mooresville 980-721-8257 Juarl Francisco :l@
SELECT SCO Contractor Raleigh 919-807-4100  Mike Gioielli - ) mike gioielli@doa.nc.gov :l@
REQUEST Easco Construction Co Inc Charlotte, NC (704)780-2378 Young, Charlene DOA.MIS. Developers@doa
REQUEST Lansco Colors Corpus Christi, TX (361)985-9696 Frank, Larry DOA.MIS. Developers@doa j@
REQUEST Lisco Cable INC Graham, NC (336)376-0616 Clark, Lisa DOA.MIS. Developers@doa @
REQUEST Pasco Concrete Construction, Inc. Greenville, NC 252-341-5110  Pascasio, Skip DOA.MIS. Developers@doa
Owner Cor | Eg
Y[ @e
1 page(s): [1]

The contractor information is automatically entered, based on your selection, in the
‘Construction Contract Detail’ tab. The Contract Status is set to “Creating” and the default
Contract Type is “General Contract.” Select an appropriate contract type if other than
“General.” Enter appropriate Award Details, Contract Dates, and Contract Amounts. Required
fields are marked with asterisks and have a red border. Entering Owner Contact, Safety Officer,
Surety, Sheets and Contractor Contact is optional.

If this is a Standard Project, the system will not allow commitments greater than the assigned

Action
. . Il save . . . .
funds. To avoid losing data, you can : as long as the status is “Creating.” When sufficient
Action
] save

funds are available to award the contract, change the status to “Valid Contract” and
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Program #: 12153 - St. Construction - Minor Renovations
_Project #: 12285 - St Construction - Renovate lobby

__ Design #: 16-12285-01 - SCO Designer

__ Package: 16-12285-01A - Renovate lobby

___ Construction Contract #: 16-12285-01A-1 - SCO Contractor

Construction Contract Detail Bid ltems HUB Good-Faith Efforts. HUB Participation Change Orders
LZ| Action @Close
Contract Summary Contractor Award Details
Formal N Award Type: Single Prime
Contract: Name: SCO Contractor [ A T BT
. = pproved For Bid: -06- (7]
Ccsyrtl;:'r:ac!. Valid Contract Address: 301 N. Wilmington Street
us: Actual Bid: 2015-07-02 @
* Contract| General Contract v Suite 450
Type: Awarded: 2015-07-07 @
Negotiation? | v Raleigh, NC 27601
Bid Number: SCO-16-12285-01A HEEEER
Final Change State Construction Contact: Contract Dates
Order Contract Date: 2015-07-13 @
Approval:
Contracts Approved 2015-07-14 @
by Agency:
Contracts Approved @
by Atty Genl:
Projected Completion: 2015-09-18 @
Owner Contact Construction Start|07/20/2013
(NTP):
i
Contract Amounts

Project Financial Worksheet Summary:

Surety
Name: Assigned Funds: $120,000
Address: Total Committed: $109,000
Safety Officer
Available to Commit: $11,000
This Contract: §98,500
Agent:
Available to Commit
Address: After Contract Approval $11,000
Worksheet Detail
Sheets Contract Amounts:
Amount Days
Original: $98,500.00 60
Change Order: $0.00 0

Current: $98,500.00 60

Select the ‘Project #:’ tab in the hierarchy, then the ‘Financial Worksheet’ tab. The construction
contract now shows up as a commitment.
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Program #: 12153 - St. Construction - Miner Renovations

_Project #: 12285 - St. Construction - Renovate lobby

Project Cost Estimate Project Type Funds Assigned Financial Worksheet Contracts P6 Link Milestones Closeout Project
Estimated vs Committed Contingency Expenditures - Design Expenditures - Construction Expenditures - Other
@Close
Worksheet Summary
Assigned Funds: $120,000.00 Assigned Funds: $120,000.00
Total Estimated Cost: $118,000.00 Total Committed: $109,000.00
Estimated Surplus (Need): $2,000.00 Available to Commit: $11,000.00

Assign Funds

Worksheet Detail

Design Fee $
Construction $:
Contingency $:
Other §

otal

Committed

Estimated Cost Original Contracts: Revised Contracts Expended

$ 10,000.00 $ 10,000.00 $ 10,500.00 $ 0.00
$ | 100,000.00 $ 98,500.00 $ 98,500.00 $ 0.00
$ 3,000.00

$ 5,000.00 $ 0.00 $ 0.00 $ 0.00

L

Construction Contract Change Orders

1. For Formal Projects

The construction change order process provides an electronic process for submitting
and approving changes to projects with construction costs over $500,000 and is
controlled by a work flow that requires the sequential execution of the steps by the
respective parties. Change orders for smaller projects are not processed electronically,
but use a simple spreadsheet shown at the end of this section, to record change order
information.

Only Designers (or InterscopePlus users given the appropriate permission) are allowed
to create and submit change orders for review, processing and approval. The electronic
change order process is used for all formal projects, both those subject to SCO oversight
and University “download” projects. University change orders follow a slightly different
approval process, with the final approval being at the University level rather than at
Sco,

a) Creating the Change Order

NOTE:

change

Each Proposed Change Order (PCO) requires supporting documentation to be

uploaded for review and acceptance. A PCO cannot be added without supporting
documentation. It is recommended that all supporting documentation be gathered prior to

order entry.

After logging in, the designer selects the Active Construction Contracts tab on
his/her Home screen, then selects the contract for which the Change Order (CO)
will be entered and clicks on it.
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,’ InterSCOPE :: State Of North Carolina - State Construction USER: scodesigner VIEW: SCO Designer
Office
2t Home = New 4, Projects 8 My Account My Company @ Help
My Favorites | Active Desion Contracts Active Construction Contracts _ Channe Orders In Process My Proiects
CONTRACT# AGENCY DESIGNER CONTRACTOR TYPE -
1 14-11274-01A-1 Miscellaneous SCO Designer SCO Contractor General Contract "
2 € 14-11339-01A-1 7;Cun5tructiun SCO Designer SCO Contractor General Contract 52
»

4 mr

2 found Export

Tip:  Use the SCO File# to identify the correct Construction Contract. |

On the Construction Contract Screen, select the Change Orders tab, then go to
FﬂA}:tmn
1" Add Change Order

= Expont

__Design #: 14-11339-01 - SCO Designer
___Package: 14-11339-01A - Enlarge Conference Room
Construction Contract #: 14.11339-01A-1 - SCO Contractor

Construction Contract Change Orders Bid ltems HUB Participation

12l Action @Close
CHANGE ORDER #  DAYS AMOUNT RECEIVED LAST STATUS. STATUS of ¥ gdd Change OMQ [ ]

= Expont

Enter the appropriate information. To upload files, select at the
bottom of the screen,

In the File Uploader window, select Choose File to browse for the file to upload.

s

File Uploader

(| Choose File | Mo file chosen
Add File to List

( ]
Cancel

To Upload Files:
1 - [Browse] and select file

2 - [Add File to List]

3 - [Upload File(s)] when ready to transmit files

Description

[upeasriec | cuse

When the file is selected, it will be uploaded to the window. Upload as many
files as necessary. Add a description and
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File Uploader

Choose File | No file chosen

Add File to List

)

[_) ChangeOrders.doc - application/msword (2068992bytes)

icedocument spreadsheetml.sheet (8519bytes)
Remove file(s) from List
To Upload Files:

1 - [Browse] and select file
2- [Add File to List]
3 - [Upload File(s)] when ready to transmit files

() Change Order Proposal 04-06-15.xIsx - application/vnd. openxmiformats-

Cancel

Upload File(s) |

leAcmn !

e save
X Delete
= rint
To add more PCOs, click the -4&=D
’
|Action
= save
__Design #: 15-11026-01 - SCO Designer
___Package: 15-11026-01A - Enlarge conference room
Construction Contract #: 15-11026-01A-1 - SCO Confractor
NEW CHANGE ORDER:
Detail
Status.
Package Status: Under Consiruction Status: Creating
Centract Status: Valid Confract Status Date:

Designer Summary

1. Schedule Items affected by this change: [Electrical |

2. Can Contractor mitigate the change without requiring a contract time extentsion:

and repeat the steps for each PCO, then

A action

@cClose

Date Received:
Last Update:

Total Days:

(1]
Total Ameunt: $0.00

3. Select the Contractors that will need a contract time extension due to this change: ‘

4. Are additional costs incurred by reason of the time extension? (if so, include in items 5&6 below):

Contractor Designer

5. Estimated Cost of Change: ‘ | | ‘

6. Estimated time extension field cost ($), if any: [ ] [ ]

Cost Summary - Note: "Revised Contract” days and amounts are pending final approval.

CONTRACT START  + CrANGE OoRDERS = CURRENTCONTRACT  (+/-) THIS ORDER
(apPROVED)
Construction Days 30 - 0 = 30 (+F) 0
Cost (8) $135,000 + $0 = $135,000 +1-) $0.00

Schedule Summary - Note: "Revised Completion™ date is pending final approval.

CONTRACT START
04/03/2015

+

30 05/03/2015

BRIOR APPROVED CO DAYS
1] 05/03/2015

PCO Breakdowns
=lpco#

PRIOR APPROVED COMPLETION DATE

Revised Contract (PENDING)

30
$135,000.00

+

Revised Completion (PENDING)

THIS ORDER
0 05/03/2015

DESCRIPTION OF PCO REASON(S) FOR CHANGE(S) PCO COST #DAYS
(Provide adequate detail to enable SCO to properly assign the cause (Provide adequate detail to property justify cause codes)
codes)
|Add data connection for projector (Original design was for all wireless internet. Projector requires 1,000.00| | DI
hard wired connection
DESCRIPTION FILE NaME UPLOADED BY DaTE a
Contractors proposal Change Order Proposal 04-06-15.x1sx Delete i
4 »
Upload Files
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After it is saved, it will show as Change Order # with the next sequential

number, show the Status and the Work Flow Activity and the ® "% jcon
appears.

Change Order added successfully
__ Design #: 15-11026-01 - SCO Designer

__ Package: 15-11026-01A - Enlarge conference room

Censtruction Contract#: 15-11026-01A-1 - SCO Contracior

Change Order #: 1

Detail

[Zlaction @Close

g

Package Status: Under Construction status: Created Date Received: Total Days: 0
Contract Status: Valid Contract Status Date: 4/21/2015 2:50:00 PM Last Update: 4/21/2015 2:50:00 PM Total Amount: $1,000
Mcﬂkflow Activity
sTep| aAcmion | acmiver ROLE FIRM/AGENCY USER COMPLETING STEP COMPLETED ON ALERTED ON RESULT comMMENTS

1 CREATE N DESIGNER SCO Designer scodesigner 0412112015 14:50 Created

2 susmIT Y DESIGNER SCO Designer

3 | ApPROVE N CONTRACTOR SCO Contractor

4 | apPrOvE N DESIGNER SCO Designer

5 | APPROVE N OWNER St. Gonstruction

6 | APPROVE N SCO St. Construction

Designer Summary

1. Schedule Items affected by this change: [Eiecirical |

2. Can Contractor mitigate the change without requiring a contract time extentsiol

3. Select the Contractors that will need a contract time extension due to this change: |

4. Are additional costs incurred by reason of the time extension? (if so, include in items 5&6 below):

Contractor Designer
5. Estimated Cost of Change: [ q [ q
&. Estimated time extension field cost ($), if any: [ 0.00] [ 0.00]

Cost Summary - Note: "Revised Contract” days and amounts are pending final approval.

pess— CHANGE CRDERS

= CURRENT CONTRACT ~ (+/-) THISORDER | = Revised Contract (PENDING)

(APPROVED)
Construction Days 30 + = 30 1) 0 = 30
Cost (8) $135,000 + $0 = $135,000 +) $1.000 = $136.000.00
Schedule Summary - Note: "Revised Completion” date is pending final approval.
CONTRACTSTART ~ +  ORIGINALDAYS | = | ORIGINAL COMPLETIONDATE | +  PRIOR APPROVEDCODAYS = | PRIOR APPROVED compLeTionDATE | +  THioRoER | = Revised Completion (PENDING)
04/03/2015 + 30 = 05/03/2015 + 0 = 05/03/2015 + 0 = 05/03/2015
PCO Breakdowns
[=lPco1
DESCRIPTION OF PCO REASON(S) FOR CHANGE(S) PCO COST #DAYS
(Provide adequate detail to enable SCO to properly assign the cause (Provide adequate detail to properly justify cause codes)
codes)
[Add data connection for projector [original design was for all wireless intemet. Projector requires [ 1,000] [ ]
Inard wired connection
DESCRIPTION FILE NAME UPLGADED BY DATE
Contractors Proposal Change Order Proposal 04-06-15.xIsx scodesigner 4/21/2015 2:49:48 PM  Delete

The Designer may continue to make changes to the Change Order using the

up until the time that the Change Order is submitted.

The Designer may choose to abandon or delete the Change Order using the

e save

=] Print

Ao However, once it is submitted, no changes or deletions are allowed
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b) Submitting the Change Order for Review

To complete this workflow step, the Designer must submit the Change Order to
initiate its review and approval by other Project participants. Up to this point, no
other Project participant has been involved in the Change Order processing.

[P Workiow

]

Submit the Change Order by selecting the. 4 A Confirmation window will
appear to confirm this action. Select Yes to continue or No to return.

The Change Order workflow is updated and processes any Alerts that are
defined for this step.

The system is configured to send Alerts to the Owner, Contractor and Project
Monitor. An Alert is sent for each logon associated with each project role.

1 alerts created for users: scocontract
Change order has been submitted by scodesigner
__Design #: 15-11026-01 - SCO Designer

__Package: 15-11026-01A - Enlarge conference room
Construction Contract #: 15-11026-01A-1 - SCO Contractor
Change Order # 1

Detail
&Fworkflow  lAction @Close
Status.
Package Status: Under Construction Status: Submitted Date Received: Total Days: []
Contract Status: Valid Contract Status Date: 4/21/2015 2:50:00 PM Last Update: 4/21/2015 2:50:00 PM Total Amount: $1,000
Workflow Activity
stee | acmon | acmver ROLE FIRM/AGENCY USER COMPLETING STEP compeTEDON | ALeRTED ON ResuLT comments
1 CREATE N DESIGNER SCO Designer scodesigner 0412142015 14:50 Created
2 susMIT N DESIGNER SCO Designer stodesigner 0412172015 15:41 Submitted
3 APPROVE Y CONTRACTOR SCO Contractor
4 APPROVE N DESIGNER SCO Designer
APPROVE N OWNER St. Construction
6 APPROVE N 8Co St. Construction

Each participant will receive an alert via email concerning actions for each
Change Order.

B Change Order # 15 is Submitted for Project#: 000609703 C Title: Scienc... - Message (HTML) =1

i Fle Edt Wiew Insert Format  Tools  Actions  Help

i pRenly | CRReply oAl | pForward | | A Y S| X2 v -a @

Fram: StateConstructionCffice@doa.nc, gov Senk:  Fri 6f19/2009 5:55 PM
Ton Giaielli, Mike
Ca

Subject:  Change Order # 15 is Submitted For Project#: 000609703 C Tite: Scienc. ..

North Carolina State Construction Office - interScope System Alert
Date:  Fridun1817:55:15 EDT 2004

Ta: tstoneking@halfourbeattyus.com

From:  rike.gioielli@doa ne.gov

You are receiving an alert concerning the following document in InterScope

Change Crder# 15 is Submitted for Project#: 000609703 & Title: Science Complex Phase |- Physical Science Building (Formerly Mew Yenable Hally

‘Warkflow Step - 2 of 6 - SUBMIT - DESIGNER: William Wilson Associated Architects, Inc. USER: wilsonarch

Click here to logon to InterScope and view it
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To access the Change Order, simply click on the link at the bottom of the Alert
Email.

You will be prompted to Logon and are then directed immediately to the
Change Order page

d) Reviewing and Approving Change Orders
Each participant will receive an alert via email concerning actions for each
Change Order.

When the Contractor logs on to InterscopePlus, he/she sees a “Change Orders
In Progress” clipboard on his/her Home screen. By selecting a Change Order,
he/she can view the Work Flow Activity of that Change Order. Change Orders
that are awaiting their action are highlighted in yellow. At this workflow step
there are only 2 options that can be performed — Approve or Reject. They are

@‘ Workflow I
)
% Approve

<! Reject

available from the§

Approving the Change Order moves the process along to the next step in the
Workflow.

Rejecting the Change Order at any step in the Workflow causes the Change
Order to be returned to Step 2 where the originator (Designer) can change and
resubmit. The workflow is then reset and the audit trail (found at the bottom of
the page) maintains a record of the prior workflow events.

This process continues until the final Workflow Step is completed and the
Change Order is marked as Approved (See Status field).

Alerts are sent to all Project participants as a notification that the Change Order
has been officially approved.
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Construction Contract #: 15-11026-01A-1 - SCO Contractor
Change Order #: 1
Detail
Status 3 (A-F;prové
Package Status: Under Construction Status: Submitted Date Received: 3 CR"EI.ECD ys: 0
Contract Status: Valid Contract Status Date: 4/21/2015 2:50:00 PM Last Update: 4/21/2015 2:50:0C . . it $1,000
Workflow Activity
USER
COMPLETED| ALERTED
STEP| ACTION |ACTIVE? ROLE FIRM/AGENCY | COMPLETING e s RESULT COMMENTS
STEP
sSco 04/21/2015
1 CREATE N DESIGNER Designer scodesigner 1450 Created |
SCo 04/21/2015
2 SUBMIT N DESIGNER Designer scodesigner 1541 |
3 |APPROVE| Y [CONTRACTOR| sco I
Contractor
4 |APPROVE N DESIGNER sco I
Designer
St
5 |APPROVE N OWNER I
Construction
6 |APPROVE[ N sco St |
Construction

The owner must certify that sufficient funds are available for the change order
before approving. Sufficient funding must be reflected in the InterscopePlus
system before the change will be approved by SCO.

Project Financial Worksheet Summary

Assigned Funds $150,000
Total Committed: $145,000

. o The owner certifies that the project's Assigned Funds are _

SeisbeloiCopnit $5.000 adequate to support this change order: Yes
This Change: $1,000
Available to Commit After this Change: $4,000
Worksheet Detail
e) Change Order Sequencing

Change orders must be entered, submitted and approved in sequence. There
are safeguards in place to check for any outstanding prior change orders before
a newer change order can be approved.

Change orders may also be deleted at any time before submission. The system
will review the current sequence of change orders and re-sequence them as
appropriate to maintain a consistent ordering.

2. Informal Project Change Orders
The change order process for informal projects involves making entries to identify the nature of
the change, cost, and impact on contract days into a spreadsheet format on the ‘Change Order’
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tab on the construction contract.
___ Construction Contract #: 15-11461-01A-1 - | L Long Construction Co_, Inc_

Construction Contract Detail Bid Items HUB Good-Faith Efforts HUB Participation Change Orders
[ Action @Close
Change Orders Summary
CHANGE ORDERS _ CONTRACT LIS _
CONTRACT START | + (CURRENT) E (CURRENT) (+/-)) ORDERS = CONTRACT (NEW)
(NEW)
Construction Days 45 + 0 = 45 (+-) 0 = 45
Cost(3) $450,000.00 + $0.00 = $450,000.00 (+-) $0.00 = $450,000.00
CHANGE ORDER # DESCRIPTION DAYS AMOUNT
i 2 \ X

Click in the Description block and enter the description of the change. Tab to fill in any
additional days and tab to enter amount of change. Change orders are automatically
numbered in the order entered. You may enter as many change orders as necessary,

E Action

4= The changes are reflected in the Change Orders Summary.

then
Construction Contract #: 15-11461-01A-1 - |. L. Long Construction Co., Inc.
Construction Contract Detail | Bid ltems HUB Good-Faith Efforts HUB Participation | Change Orders
LZ Action Close

Change Orders Summary

CHANGE ORDERS CONTRACT SlancE

CONTRACT START + (ool | = e (+1) o(RNEéSVR)s - CONTRACT (NEW)
Construction Days 45 + 0 = 45 (+1) o = 48
Cost(s) $450,000.00 + $0.00 = $450,000.00 (+ - $452,500.00
b

CHANGE ORDER # DESCRIPTION \DAYS AMOUNT
Add additional curb cut @ X
X

On the ‘Construction Contract Detail’ tab, the total of all change order amounts are also shown.

Contract Amounts

Project Financial Worksheet Summary:

Assigned Funds: $498,000
Total Committed: $493,606
Available to Commit: $4,304
This Contract: $452 500

Available to Commit
After Contract Approval $4,304

Worksheet Detail

éontract Amounts: \\

Amount Days
Original: $450,000.00 45
Change Order: $2,500.00 3

Current: $452 500.00 48

\ S
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N. Contingency Funds

Within the context of InterscopePlus, contingency funds are the construction contingency funds
that are shown as a line item in the design contract. The amount entered in the estimated cost
field for contingency is automatically carried into the design contract, but can be modified
before contract commitment. Some Agencies/Institutions choose to use the contingency line as
a total project contingency, which is acceptable. For projects with SCO Full Oversight, the
amount of construction contingency must be clearly communicated to SCO at the time of design
negotiations.

The financial controls look at the assigned funds and the total commitments, and will only allow
commitments up to the amount of assigned funds. There is no requirement to update
estimated costs to be in agreement with commitments, however the user may do so. There is
no mechanism for committing or expending funds from the contingency line. The simplest way
to move contingency funds is in the ‘Financial Worksheet’> ‘Estimated vs Committed’ tab. Here
the amount in the Estimated Cost can be changed by entering the new amount and “
A transaction of this type is shown in the example below.

If a more detailed audit trail is desired, the entries may be made directly on the Contingency
tab.

Program #: 9882 - UNC School Of The Arts - 2016 R&R
_Project #: 10876 - UNC School Of The Arts - Replace roof - Workplace

Project Cost Estimate Project Type Funds Assigned Financial Worksheet Contracts Milestones Closeout Project
Estimated vs Committed Contingency Expenditures - Design Expenditures - Construction Expenditures - Other
& Close
Track Contingency Amounts m
A ically draw down i ts to fund change orders
Contingency Amount
Current Total Change New TotalReasen for Change Transfer To Recorded On Recorded By
$10,000.00 § _500.00)8 9,500, 06 ncrease to 'Other funds > @ v | 522015 trainer
History of Changes
Current Total Change New Total Reason Transfer To Recorded On Recorded By
$0.00 $10,000.00 $10,000.00 Tnitial Amount from Estimate N/A 05/08/2015 Rich Cox
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Enter the amount of change, or the new total, the reason for the change and where the funds

are going. Then INIEZSEN .

Program #: 9882 - UNC School Of The Arts - 2016 R&R
_Project #: 10876 - UNC School Of The Aris - Replace roof - Workplace

Contingency Data saved successfully.

Project Cost Estimate Project Type Funds Assigned Financial Worksheet Contracts Milestones. Closeout Project
Estimated vs Committed Contingency Expenditures - Design Expenditures - Construction Expenditures - Other
D Close
Track Contingency Amounts m
A ically draw down i ts to fund change orders

Contingency Amount

Current Total Change New TotalReason for Change Transfer To Recorded On Recorded By

$9,500.00| $ 0.00 0.00 N/A Y 5/8/2015 trainer

History of Changes

Current Total Change New Total Reason Transfer To Recorded On Recorded By
$10,000.00 ($500.00) $9,500.00 Increase to ‘Other’ funds OTHER 05/08/2015 Rich Cox
$0.00 $10,000.00 $10,000.00 Initial Amount from Estimate N/A 05/08/2015 Rich Cox

The “History of Changes” tracks all changes in Contingency regardless of the method of change.

0. Entering Other Commitments

Other Commitments are those owner expenses related to the project that do not involve design
or construction contracts, typically things like advertising, surveys, permit fees, etc.

NOTE: Commissioning, Special Inspections, and similar services that are selected using the
design contract procedures must be recorded as design contracts, not Other commitments.

Navigate to the Project ‘Financial Worksheet’> ‘Estimated vs Committed’ tab.
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Program #: 9882 - UNC School Of The Arts - 2016 R&R
_Project #: 10876 - UNC School Of The Aris - Replace roof - Workplace

Project |~ CostEstimate |~ Project Type |~ FundsAssigned | Financial Worksheet Contracts |~ P6Link |~ Miestones |
Estimated vs Committed Contingency |~ Expenditures - Design |~ Expenditures - Construction |~ Expenditures - Other |
EClose
Worksheet Summary m
Assigned Funds: $100,000.00 Assigned Funds: $100,000.00
Total Estimated Cost: $350,000.00 Total Committed: $98,000.00

Estimated Surplus (Need): ($250,000.00) Available to Commit: $2,000.00

Assign Funds

Worksheet Detail

@ Enter Category Estimates

) Enter Total Estimates

Committed
Estimated Cost Original Contracts vised Contracts Expended

Design Fee § B 25,000.00 $ 26,000.00| $ 0.00
Construction §: % | 300,00000 $ 72,000.00| § 0.00
Contingency $: 5 10,000.00
Qther §: 3 r 15,000 DD 5 0.00 $ 0.00| $ 0.00

33500‘.}0021 $97,000.00

The Estimated Cost Other $ shows $15,000 but the amount of funds Available to Commit is only
$2000, and the system will not allow committing more funds than are available. This financial
constraint does not apply to Special Project Designations (Performance Contract, Foundation

Project, Non-Code-Item Project).
Select the ‘Expenditures — Other’ tab

Program #: 9882 - UNC School Of The Arts - 2016 R&R
_Project #: 10876 - UNC School Of The Arts - Replace roof - Workplace

Project |~ Cost Estimate |~ Project Type |~ FundsAssigned | Financial Worksheet Contracts |~ PG Link |~ Milestones |
Estimated vs Commitied | Contingency I. Expenditures - Design |~ ' Expenditures - Construction ] Expenditures - Other
&3 Close
Expenditure Details “
Cost Category: Other

Add |:| ling(s) <=

Enter the number of lines you want to add, 1 line for each PO or other commitment and click

the <= sign.
Program #: 9882 - UNC School Of The Arts - 2016 R&R
_Project #: 10876 - UNC School Of The Arts - Replace roof - Workplace
Project |.” CostEstimate |~ Project Type |~ Funds Assigned | Financial Worksheet Contracts |~ P&Link |~ Milestones |
Estimated vs Committed |~ Contingency |~ Expenditures - Design |~ Expenditures - Construction | Expenditures - Other
Close
Expenditure Details “
Cost Category: Other
Add D line(s) <=
HUB?Commitment # Purpose ‘Vendor Commitment Amt Open Amt Invoice
3 Delete
@ | I /| | s 0.0 $0.00 Add Invoice Commiment
otal $0.00 $0.00 $0.00
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If the vendor is a HUB, check the box at the left. Assign a commitment #, which can be a PO
number or anything you want, a purpose or description of what is being purchased, the vendor,
and the commitment amount, then IBBES3M . HUB Vendors must be selected from the vendor
search because their certification status is validated as part of the data entry process, but other
vendors can be entered by typing the name.

Commitment(s) and Expenditures Saved successfully |
Program #: 9882 - UNC School Of The Arts - 2016 R&R
_Project #: 10876 - UNC School Of The Aris - Replace roof - Workplace

Project Cost Estimate Project Type Funds Assigned Financial Worksheet Contracts PG Link Milestones
Estimated vs Committed Contingency Expenditures - Design Expenditures - Construction Expenditures - Other
EClose
Expenditure Details m
Cost Category: Other
Add line(s) =
HUB? Commitment # Purpose Wendor Commitment Amt Open Amt Invoice:
Regional Land $ Delste
@[ Survey Surveyors, Inc Search 1,500.00 $1,500.00,Add Invoice Commitment
o siom0 s |

Unlike design or construction contracts, there is no formal process for changing these
commitments. If there is an increase or decrease to the commitment amount, simply enter the
new correct amount in the Commitment Amt. and IBICSM . Entering expenditures
(payments/invoices) is optional. If there are invoices entered, the commitment amount cannot
be reduced below the expenditures and the commitment cannot be deleted.

All of the information from this tab rolls up automatically to the ‘Estimated vs Committed’ tab,
as shown below.

Program #: 9882 - UNC School Of The Arts - 2016 R&R
_Project #: 10876 - UNC School Of The Arts - Replace roof - Workplace

Project Cost Estimate Project Type Funds Assigned Financial Worksheet Contracts P6 Link Milestones
Estimated vs Committed Contingency Expenditures - Design Expenditures - Construction Expenditures - Other
Close
Worksheet Summary “
Assigned Funds: $100,000.00 Assigned Funds: $100,000.00
Total Estimated Cost: $350,000.00 Total Committed: $99,500.00
Estimated Surplus (Need): ($250,000.00) Available to Commit: $500.00

Assign Funds

Worksheet Detail
«) Enter Category Estimates
Enter Total Estimates
Committed
Estimated Cost Original Contracts Revised Contracts Expended
Design Fee § 25,000.00 5 25,000.00 $ 26,000.00 5 0.00
Construction §: 300,000.00 § 72,000.00 $ 72,000.00 $ 0.00

10,000.00
Other § 15,000.00

oo

Contingency $:

-3
5
3
-3 § 0.00

$ 1,500.00
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P. Entering Expenditures
Entering expenditures is optional in this system since it is not designed to be an accounting
system, but the opportunity for these entries was provided to assist users in tracking payments

to designers, contractors, and other vendors.

1. Designer Expenditures

Navigate to the ‘Financial Worksheet’> ‘Expenditures — Design’ tab, and click on ‘Add

New Row.’

Program #: 9920 - St. Construction - New Office Complex
_Project #: 10929 - St. Construction - Construct Building

Project |~ Cost Estimate | Projeci Type |~ Funds Assigned | Financial Worksheet Contracts |~ P6 Link_ |

Milestones |

Estimated vs Committed |~ Contingency |~ Expenditures - Design Expenditures - Construction |

Expenditure Details

Cost Category: Design

Commitment: #1 - SCO Designer

Expenditures - Other |

EClose

Enter the invoice number, date, and amount. If you are tracking multiple funding
sources, insert the proper funding code from which the funds were taken for the

invoice. Then INEZEN

Program #: 9920 - St. Construction - New Office Complex
_Project #: 10929 - St. Construction - Construct Building

Closeout Project
Project Cost Estimate

Estimated vs Commiited

Expenditure Details

otal: Design Contracts

Project Type
Contingency

Funds Assigned

Expenditures - Design

Financial Worksheet

Expenditures - Construction

Contracts Milestones

Expenditures - Other

Cost Category: Design
Commitment: #1 - SCO Designer Add New Row
vendor Commified  Invoke Amount Agency Funding open
Cooe
SCO Designer 1 03/17/2015 [W § 6000000 Delete
$3.500,000.00 $60,000.00 $3,440,000.00
$3,500,000.00 $60,000.00 $3.440,000.00

The amount expended and remaining balance are shown on the Total Design Contracts
line. Note that if you now go to the ‘Estimated vs Committed’ tab, the expenditure also
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appears.

Program #: 9920 - St. Construction - New Office Complex
_Project #: 10929 - St. Construction - Construct Building

Project |~ CostEstimate | ProjectType |~ FundsAssigned |~ Financial Worksheet |~ Contracts |~ Milestones |

Estimated vs Committed Contingency |~ Expenditures - Design |~ Expenditures - Construction |~ Expenditures - Other |

@ Close
Worksheet Summary m

Assigned Funds: $25,000,000.00 Assigned Funds: $25,000,000.00
Total Estimated Cost: $50,000,000.00 Total Committed: $22,000,000.00
Estimated Surplus (Need):  (§25,000,000.00) Available to Commit: _ $3.000,000.00
ASSlgﬂ Funds

Worksheet Detail

‘Committed
Estimated Cost Original Contracts Revised Contracts Expended
Design Fee § $ $ 3,500,000.00 $ 3,500,000.00 $ 60,000.00
Construction $: $ $ 18500,000.00  $ 18,500,000.00 $ 0.00
Contingency $: )
Other §: $ 5 0.00 $ 0.00 $ 0.00

I R

2. Construction Expenditures
Construction expenditures are recorded similarly to Designer expenditures. Navigate to
the ‘Financial Worksheet’ > ‘Expenditures — Construction’ tab, and click on ‘Add New

7

Row.

Program #: 9920 - St. Construction - New Office Complex
_Project #: 10929 - St. Construction - Construct Building

Project |~ CostEstimate |~ Project Type |~ FundsAssigned |  Financial Worksheet contracts |~ P& Link |~ Miestones
Estimated vs Committed | Contingency | Expenditures - Design | Expenditures - Construction | Expenditures - Other ]
D Close
Expenditure Details m
Cost Category: Construction
Commitment: #1 - SCO Contractor Cadd New R@
otal: Construction Contracts $18,500,000.00 $0.00 $18,500,000.00

Enter the invoice number, date, and amount. If you are tracking multiple funding
sources, insert the proper funding code from which the funds were taken for the

invoice. Then INIETEN

Expenditures Saved successfully
Program #: 9920 - St. Construction - New Office Complex
_Project #: 10929 - St. Construction - Construct Building

Project | Cost Estimate | Project Type | Funds Assigned | Financial Worksheet Contracts | P6 Link_| Milestones |
Estimated vs Committed |~ Contingency |~ Expenditures - Design |~ Expenditures - Construction Expenditures - Other |
DClose
Expenditure Details m
Cost Category: Construction
Commitment: #1 - SCO Contractor Add New Row
\vendor Committed Invoice  Date: Amount  Agency Gpen
Funding Code
SCO Contractor [04/08/2015 6] 5[ 50,000.00] | Delete
$50,000.00 $18,450,000.00

$18,450,000.00

otal: Construction Contracts
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The amount expended and remaining balance are shown on the Total Construction
Contracts line. Again, if you now go to the ‘Estimated vs Committed’ tab, the
expenditure also appears.

Expenditures Saved successfully

Program #: 9920 - St. Construction - New Office Complex
_Project #: 10929 - St. Construction - Construct Building

Project |~ CostEstimate |~ Project Type |~ Funds Assigned | ~ Financial Worksheet Contracts |~ P6Link |~ Miestones |
Estimated vs Committed Contingency |~ Expenditures - Design |~ Expenditures - Construction |~ Expenditures - Other |
A Close
Worksheet Summary m
Assigned Funds: $25,000,000.00 Assigned Funds: $25,000,000.00
Total Estimated Cost: $50,000,000.00 Total Committed: $22,000,000.00
Estimated Surplus (Need): ($25,000,000.00) Available to Commit: $3,000,000.00

Assign Funds

Worksheet Detail

Committed
Estimated Cost Criginal Contracts Revised Contracts Expended
Design Fes § $ | 5,000,000.00 § 3,500,000.00 $ 3,500,000.00 §$ 60,000.00
Construction $: ¥ | 40,100,000.00 $ 18,500,000.00 § 18.500,000.00 $ 50,000.00
Contingency $: $ 900,000.00
Other §: | 4,000,000.00 $ 000 $ 0.00 $ 0.00

3. Other Expenditures

To enter Other expenditures, a commitment needs to exist first. See Entering Other
Commitments. Navigate to the ‘Financial Worksheet’ > ‘Expenditures — Other’ tab and
click “Add Invoice.”

Program #: 9920 - St. Construction - New Office Complex
_Project #: 10929 - Si. Construction - Construct Building
Project |~ Cost Estimate | Project Type | Funds Assigned | ~ Financial Worksheet Contracts |-~ P6 Link | milestones |
Estimated vs Committed |~ Contingency |~ Expenditures - Design |~ Expenditures - Construction | Expenditures - Other
Close
Expenditure Details m
Cost Category: Other
Add line(s) <
HUB?Commitment # Purpose Vendor Commitment Amt Open Amt Invoice
@fi Survey Survey Master s[ 12.00000] $12000 u@gd\nvmce o e
otal $12.00000 $12,000.00 $0.00

As with Design and Construction Expenditures, enter the invoice number, date, and
amount. If you are tracking multiple funding sources, insert the proper funding code
from which the funds were taken for the invoice. Then IIEZIN
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Q.

Commitment(s) and Expenditures Saved successfully
Program #: 9920 - St. Construction - New Office Complex
_Project #: 10929 - St. Construction - Construct Building
Project Cost Estimate |~ Project Type | Funds Assigned | ~ Financial Worksheet Confracts P6 Link | Milestones |
Estimated vs Committed Contingency | Expenditures - Design _| Expenditures - Construction | Expenditures - Other
@Close
Expenditure Details “
Cost Category: Other
Add line(s) <=
HUB? Commitment # Purpose ‘endor Commitment Amt Open Amt Invoice
1 Survey Survey Master s[ 12.000.00 $6,000.00 | Invoice# Invoice Date Invoice Amt  Agency
Funding Code:
1 04/08/2015 |[Els|[6,000.00 Delete|  Delete
Commitment
Add Invoice
otal $12,000.00 $6,000.00 $6,000.00
The amount expended and remaining balance are shown to the Total line and the
expenditure appears on the ‘Estimated vs Committed’ tab.
Program #: 9920 - St. Construction - New Office Complex
_Project #: 10929 - St. Construction - Construct Building
Project Cost Estimate |~ Project Type Funds Assigned Financial Worksheet Contracts PE Link |~ Milestones
Estimated vs Committed Contingency Expenditures - Design Expenditures - Construction Expenditures - Other |
EClose
Worksheet Summary m
Assigned Funds: $25,000,000.00 Assigned Funds: $25,000,000.00
Total Estimated Cost: $50,000,000.00 Total Committed: $22,012,000.00
Estimated Surplus (Need): ($25.000,000.00) Available to Commit: $2,988,000.00

Assign Funds
Worksheet Detail

Committed
Estimated Cost Original Contracts Revised Contracts Expended
Design Fee § $ [ 5,000,000.00 $ 3,500,000.00 $ 3,500,000.00 § 60,000.00
Construction § $ | 40,100,000.00 $ 18,500,000.00 $ 18,500,000.00 § 50,000.00
Contingency § 3 900,000.00
Other §: $ [ 4,000,000.00 $ 12,000.00 $ 12,000.00 $ 6,000.00

Entering HUB Data
HUB data must be entered as part of a construction contract.

For Standard Projects with designers or SCO code review, HUB data should be entered at the
time of contract award, and the data is saved as “At award.” The Good Faith Effort must be
entered. For formal contracts awarded by SCO, data “At award” will entered by them. HUB
data should be updated as it changes through the life of the contract and verified before the
project is closed. Updating/finalizing HUB data will be the responsibility of the owner agency,
university, or community college. A beneficial occupancy date must be entered before HUB
data can be finalized.
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Non-Code-ltem Projects that are construction only (no designer or SCO code review) can be
entered as "HUB Only,” which will allow direct creatation of a construction contract. The
project must be created as a Non-Code-ltem Project AND the HUB Only check box must be
checked in order to utilize the abbreviated data entry method.

NOTE: If a project exists in InterscopePlus because of design or code review, the
construction contract and HUB data must be entered under that project, regardless of dollar
amount of project.

1. Good Faith Efforts
Navigate to the desired ‘Project’> ‘Contracts’ tab, and select the construction contract.

Program #: 12153 - St. Construction - Minor Renovations

_Project #: 12285 - St. Construction - Renovate lobby

Project Cost Estimate Project Type Funds Assigned Financial Worksheet Contracts P6 Link Milestones Closeout Project
&Close
SCO ID# FIRM STATUS PHASE TYPE OVERSIGHT o
1 16-12285-01 SCO Designer Active Desian Standard Design Limited Oversight :
2 qgs-lzzﬁs-nm-L »,5CO Contractor Valid Contract Construction General Contract Fd
-

— »

2 found Add Design Contract Export

Click on the ‘HUB Good Faith Efforts’ tab. The Good Faith Efforts must be documented
to determine if the contractor is responsive. Select the ‘HUB Good-Faith Efforts’ tab,

=2l Action

Save

. . . =
enter the appropriate information, and

Program #: 12153 - St. Construction - Minor Renovations
_Project # 12285 - St Construction - Renovate lobby

__Design #: 16-12285-01 - SCO Designer

__Package: 16-12285-01A - Renovate lobby
____Construction Contract #: 16-12285-01A-1 - SCO Contractor

Construction Contract Detail Bid Items HUB Good-Faith Efforts HUB Participation Change Orders
12 Action | EClose
R . o = save
Construction Contractor's Good-Faith Effort Affidavit State Construction Manual- Good-Faith Efforts

#/ 1 -(10 pts) Contacted minority businesses.
Affidavit Execution

2 - (10 pts) Made the construction plans, specif i and requir

available. * Company Submitting Affidavit:|SCO Contractor

3 - (15 pts) Broken down or combined elements of work. * Date:[07/02/2015
107/02/2015

4 - (10 pts) Worked with minority trade, community or contractor
organizations.

¥ 5-(10 pts) Attended prebid meetings scheduled by the public owner
6 - (20 pts) Provided assistance in getting required bonding or insurance

#| 7 -(15 pts) Negotiated in good faith with interested minority businesses.
8 - (25 pts) Provided assistance to an otherwise qualified minority
business.

9 - (20 pts) Negotiated joint venture and partnership arrangements. GFE Assessment (50 points required to be considered

responsive)
#/ 10 - (20 pts) Provided quick pay agreements and policies.

Points Achieved: 0

b 4 Not Responsive
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Once saved, the system will calculate the number of points and determine if the contractor is

responsive.

Affidavit and Good Faith Efforts updated successfully.

Program #: 12153 - St Construction - Minar Renovations
_Project #: 12285 - St. Construction - Renovate lobby

__Design #: 16-12285-01 - SCO Designer

__ Package: 16-12285-01A - Renovate lobby

__ Construction Contract #: 16-12285-01A-1 - SCO Contractor

Construction Contract Detail Bid Items HUB Good-Faith Efforts

Construction Contractor's Good-Faith Effort Affidavit

#| 1 -(10 pts) Contacted minority businesses.

2 - (10 pts) Made the construction plans, specifications and requirements

available.
3 - (15 pts) Broken down or combined elements of work.

4 - (10 pts) Worked with minority trade, community or contractor
organizations.

#| 5 -(10 pts) Attended prebid meetings scheduled by the public owner
6 - (20 pts) Provided assistance in getting required bonding or insurance

#| T -(15 pts) Negotiated in good faith with interested minority businesses.

8 - (25 pts) Provided assistance to an otherwise qualified minority
business.

9 - (20 pts) Negotiated joint venture and partnership arrangements.

#/ 10 - (20 pts) Provided quick pay agreements and policies.

HUB Participation

Change Orders
L2 Action Close

State Construction Manual: Good-Faith Efforts

Affidavit Execution

* Company Submitting Affidavit: SCO Contractor
* Date: 07/02/2013

GFE Assessment (50 points required to be considered
responsive)

Points Achieved: 75

\/ Responsive

2. HUB Entry as part of a Standard Project — Single Prime
Navigate to the desired Project Contracts tab, and select the construction contract.

Click on the ‘HUB Participation’ tab.

This provides information on the HUB status of the Prime Contractor, and the current

HUB participation.
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If the contractor has submitted an Affidavit C, on the ‘HUB Participation’ tab click on the

Add Subcontractor

Program #: 121563 - St. Construction - Minor Renovations
_Project #: 12285 - St Construction - Renovate lobby

__ Design #: 16-12285-01 - SCO Designer

__ Package: 16-12285-01A - Renovate lobby

__ Construction Contract # 16-12285-01A-1 - SCO Confractor

|~ Bid Iltems |~ HUB Good-Faith Efforts HUB Participation Change Orders

Construction Contract Detail

[ Action B Close

Construction Contract HUB Participation HUE Participation Summary (Certified Only)

Awarded Current

General Contractor: SCO Contractor
Construction Contract Amount: $98 50000 $98,500.00

GC HUB Type: Unknown S
Total HUB Participation: $0.00 $0.00
HUB Data is 7 HUB %: 0.00 % 0.00 %
FINAL as of:
Affidavit B
Affidavit
Show HUB . (GEEs req'd)
Details/Status as of Award v Source of Information: C Affdaut
o MO (GEES reqd)
Contractor HUB Type HUB Certified? CSI Division Work Awarded Current Contract ~ Payments To Date  Final
Payment?

0 found Add Subcontractor

This will bring up the “Add Subcontractor” search box. Enter information about the

Search
desired subcontractor and ——.
Add Subcontractor...
Name: pPaint Email:
HUB Certified? vy v Contact Person:
i Address:
City: State:
! Zip: Phone: (999-999-9999)
4 m @ Not Found - Submit Request
| Company City, State Voice Contact Email
LINK TOIPS  Martinez's Painting Co. Wilmington, NC (910)231-7515 Martinez, Joseph DOA.MIS.Developers@
LINK TO IPS ~ MECKLENBURG PAINT CO INC Charlotte, NC (704)588-3113 ETHEREDGE, LIZ DOA.MIS.Developers@
| LINKTOIPS Meticulous painting and drywall Knighdale, NC (919)638-0332 Withrow, Leroy DOA.MIS.Developers@
i LINKTOIPS Morrison ElectroStatic Painting, Inc. Terrell, NC 828-851-4779  Crowder, Susan DOA.MIS.Developers@
SELECT Paint Master Sanford, NC (919)776-9251 Harris, Larrry DOA.MIS.Developers@
LINK TOIPS  Painting the Carolinas, LLC Mount Holly, NC (704)827-0210 Goolsby, Charleen DOA.MIS.Developers@
LINK TOIPS  Painting the Carolinas, LLC Mount Holly, NC (704)827-0210 Goolsby, Charleen DOA.MIS.Developers@
SELECT Paintmaster LLC Wendell, NC (919)365-3201 Eberhardt, Debra DOA.MIS.Developers@ v

4

Spage(s) 123143

Select the desired contractor from the pick list. “Link TO IPS” or “SELECT” options are
displayed. The difference between these two options is a system parameter involving
where address information is stored. Any company that can be “SELECT”ed is in the
InterscopePlus database and can be used for Contractors. Companies that can be “LINK
TO IPS”ed are in IPS database but not in InterscopePlus. If the desired company is not

listed, click on the additional box for to request the addition.
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This will open a screen for entry of contractor information including name, address, and
telephone which will be routed to the system administrator for approval/entry.

Request Contractor:

Profile

@ Close

Fill out the form below as completely as possible and click "Request Contractor.” An Administrator will review your request, and you will be

notified once a decision has been made.

|Request Contractor |

* Name:

Status: Pending
* Email: *|
* Contact| *
Person:

* Line 1: *|
Line 2:
* City: +
* State: v

* 2ip:oured ]
County: UNKNOWN v
Voice#:| - -

Fax#: -

Website URL:
Parent:

Former Name:

Firm ID#: (Auto)
Last Update:

IPS Vendor:
Address:
Contact:

Email:
IPS Location:

IPS Sequence:

HUB participation information for this company or a “LINK TO IPS” company may not be
entered until the contractor is approved and loaded into the system by the System
Administrator. An automatic e-mail will be generated back to the requester when this
has been done so that HUB entries may be completed.

Add SubContractor...

Name: paint Email:
HUB Certified? Y E| Contact Person:
Address: City:
State: Zip:
Phone: (999-999-9999)
=3
It IPS Company City, State Viice Contact -
REQUEST X Maze Custom Painting, LLC Charlotte, NC (704)778-6288 Felisbret, Jason
REQUEST X MECKIENBURG PAINT CO INC Charlotte, NC (704)588-3113 ETHEREDGE, L17
REQUEST »%  Meticulous painting and drywall Knighdale, NC (919)638-0332 Withrow, Leroy
(SI;EI;ECT ) x x Paint Master Sanford, NC (919)776-9251 Harris, Larrry
REQUEST % Painting & Drywall By Villanueva Inc Raleigh, NC (919)349-0204 Villanueva, Patrick
REQUEST % Painting the Carolinas, LLC Mount Holly, NC (704)827-0210 Goolsby, Charleen
REQUEST % Painting the Carolinas, LLC Mount Holly, NC (704)827-0210 Goolsby, Charleen [
REQUEST X Paintmaster LLC Wendell, NC (919)365-3201 Eberhardt, Debra -
4 I 3

Gpage(s) 1234358
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The selected subcontractor is displayed on the contractor list, as shown below. Now

Action

complete entering the CSI Division, Work, and Awarded amount, and “**

HUB Participation data saved.
Program #: 10114 - St. Construction - Minor Renovations
_Project #: 11026 - St. Construction - Enlarge conference room
__Design #: 15-11026-01 - SCQ Designer
___Package: 15-11026-01A - Enlarge conference room
____Construction Contract #: 15-11026-01A-1 - SCO Contractor
Construction Contract Detail Bid Iltems HUB Participation HUB Good-Faith Efforts Change Orders

L2 Action Close

Construction Contract HUB Participation HUB Participation Summary (Certified Only)

Awarded Current
General —_—
SCO Contractor i
Contractor: Construction Contract $135,000.00 $135,000.00
Amount:
GC HUB Type: Not a HUB
Tvp Total HUB Participation: $15,000.00 $0.00
HUB Data is FINAL HUB %: MM% 0.00 %
Affidavit B
Show HUB Award v Source of e Afﬂdav!t &
Details/Status as of Information: Affidavit D
(MUST first enter
Good-Faith Efforts)
Contractor HUB Type HUB Certified? CSI Division Work Awarded Cumrent Contract Payments To Date  Final
Payment?
Paint Master B Y 09700 -Wall F ¥ | Vinyl Wall Covering $| 15,00000 $ 000 8 0.00 x

1 found Add Subcontractor

The HUB particpation is automatically calculated and displayed for Certified HUB
contractors. Uncertified HUB firms may be listed, but will not be reflected in the
displayed calculations. Continue adding subcontractors as necessary.

3. HUB Entry as part of a Standard Project — CM at Risk

HUB Entry for CM at Risk differs from Single Prime in that participation must be
reported for each 1% tier subcontractor. Therefore there is a Trade/Sub Package for
each 1 tier subcontractor or Package Prime Contractor, and the HUB subcontractors
under each Trade/Sub Package are recorded.
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If the construction contract was created as a CMAR, the appropriate HUB Participation

(CMAR) tab will show up under the contract.

Program #: 9920 - St. Construction - New Office Complex
_Project #: 10929 - St. Construction - Construct Building
__Design #: 16-10929-02 - SCO Designer

___Package: 16-10929-02A - Construct Building

Construction Contract #: 16-10929-02A-1 - SCO Contractor

Construction Contract Detail Bid ltems

HUB Participation (CMAR)

Construction Contract HUB Participation - CMAR

Contract

Construction Manager: SCO Contractor

CMAR HUB Type: Nota HUB

Hub Data is FINAL

Trade / Sub Packages

Add Trade / Sub Package

Pkg # 2

Show HUB Details/Status as of:

HUB Good-Faith Efforts Change Orders

For |Sitework| @elect Packafe Prime Cuntractor)

For each Trade/Sub Package, enter the Pkg# and type of work, then ‘Select Package
Prime Contractor’. The Pkg # is user-defined and may be whatever is customary for the
organization making the entries. Similarly, the type of work under For is a user-defined

entry, but should be generally descriptive of the nature of the work. Search for the
desired contractor and select them.

Zl Action & Close
HUB Participation Summary (Certified Only)
Awarded Current
Construction
Contract $18,500,000 $18,500.000
Amount:
Total HUB
s c $0 0
Participation: g
HUB %b: 0.0% 0.0%
Award v

Add SubContractor...

Name: Hijne
HUB Certified? - Sglect-- v
Address:
State:
Phone:

Email:
Contact Person:
City:
Zip:
(999-999-9999)
Company City, State Voice

Hine Sitework, Inc.

EE’Q UES)

1 page(s): [1]

Goldsboro, NC

(919)736-8990 Hine, Ann

Contz

65

[Rev. 7 —January 12, 2016]




InterscopePlus User Manual

Enter the Pkg Amount at Award. If there are HUB subcontractors for the Package Prime,
they should be added by clicking ‘Add Subcontractor.’

Program #: 9920 - St Construction - New Office Complex
_Project # 10929 - St. Construction - Construct Building
__Design #: 16-10929-02 - SCO Designer

__Package: 16-10929-02A - Construct Building

___ Construction Contract #: 16-10929-02A-1 - SCO Contractor

Construction Contract Detail Bid ltems HUB Participation (CMAR) HUB Good-Faith Efforts Change Orders
[Z action & Close
Construction Contract HUB Participation - CMAR HUB Participation Summary (Certified Only)
Contract
Awarded Current
Construction Manager: SCO Contractor c t ti
onstruction . $18,500,000  $18,500,000
CMAR HUB Type: Not a HUB Contract Amount:
Total HUB. 0 $0
Hub Data is FINAL Dastcipation
HUB %o: 0.0% 0.0%
Trade / Sub Packages Show HUB Details/Status as of: Award v
Pkg # 2 For Sitework ®
Pkg Prime{ Hine Sitework, Inc| Change Hub Type: F (Certified) Pkg Amount at Award: $ Current: §
[ 1.500.000.00
Contractor HUB Type  HUB Certified? CSI Division Work Awarded  Current Contract Payments To Da‘epa;x‘w

CA _ubcomractor)

Add Trade / Sub Package

Pkg #2 For Sitework Select Package Prime Contractor
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<2 Action

It is recommended that you ™ after each contractor, as the Hub Participation
Summary will be updated when you save.
HUB Participation data saved.

Program #: 9920 - St Construction - New Office Complex

_Project #: 10929 - St. Construction - Construct Building

__Design #: 16-10929-02 - SCO Designer

__Package: 16-10929-02A - Construct Building

____Construction Contract #: 16-10929-02A-1 - SCO Coniractor

Construction Contract Detail Bid Items HUB Participation (CMAR) HUB Good-Faith Efforts Change Orders
L2 Action EClose
Construction Contract HUB Participation - CMAR HUB Participation Summary (Certified Only)
Contract
Awarded Current
Construction Manager: SCO Contractor c t ti
ISt con . $18,500,000  $18,500,000
CMAR HUB Type: Not a HUB Contract Amount:
;“t:_l !'"-”3_ . $1,500,000 $0
Hub Data is FINAL articipation:
HUB %o: 8.1% 0.0%
Trade / Sub Packages Show HUB Details/Status as of: Award v
Pkg #|2 For|Sitework x
Pkg Prime: Hine Sitework, Inc. Change Hub Type: F (Certified) Pkg Amount at Award: $ Current: § 0.00
1,500,000.00)
Contractor HUB Type  HUB Certified? CSI Division Work Awarded  Current Contract Payments To Datepag‘r:zlnn

Add Subcontractor ...

Add Trade / Sub Package

Pkg 3 - B )_ Fo@ Select Package Prime Contractor

Continue entering Trade/Sub Packages and Subcontractors until all HUB data is
complete.

4, HUB Only data entry/Non-code-item-center entry

Small projects that are NOT part of a code-item-center capital project or, by their nature
have no design or code review such as painting, road patching, etc., need to be entered
for reporting capital activity as well as recording HUB data. All construction projects
whose construction cost is in excess of $30,000 must be reported for HUB participation
according to statute. There is an abbreviated method for these entries.

NOTE: If a project exists in InterscopePlus because of design or code review, the
construction contract and HUB data must be entered under that project,
regardless of the dollar amount of the project.

If the Project is funded from a Capital Project Code-ltem-Center, including R&R, it
must NOT be entered as a Non-Code-Item Project/HUB Only.

At the Program, navigate to the ‘Projects’ tab and click ‘Add Project’.
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Program #: 12155 - State Construction Office - 2015-2016 Non-Code-ltem Projects

Program Program Funding | Projects Assign Amounts to Projects. Program Closeout
@Close
SLNo.  Project ID Agency Project Code Project Title Status Estimated Cost Estimated Need Hi
4 3
Total $0.00

0 Projects found

Add Project

Enter the Title and Description, then select the Special Project Designhation “Non-Code-
Iltem.” Refer to Determining the Special Project Designation. The HUB Only checkbox

will appear and must be clicked to enter the checkmark. Enter an Estimated Project

Completion, Funding Source, and Fiscal Year Funded, then

Program #: 12155 - State Construction Office - 2015-2016 Non-Code-ltem Projects

NEW CAPITAL PROJECT:

Project

Project Information - Basic
* Program: 12155 - 2015-2016 Non-Code-Item Projects
* Department: Administration
* Agency: State Construction Office
Project ID: (Aufo)
* TitlegPaint 4th floor spaces

Description: paint all spaces on 4th floor

Agency Project Code:
Status: (Auto)

E Action

| save

2] Action | EClose
e save

X Delet
Standard Proje elete

Performance Contract
Foundation Project
@ Nomgode-ltem Project

Project Information - Advanced
Project Type:

* Special Project Designation:

i B Only
Project C fon((11/01/201 D&
. =
Funding Source(@enya\ Fund > v
Fiscal Year Funded: | 2015 - 2016 v
Financial Controls: On
Bypass Financial Controls?
Estimated Cost
Estimated Project Cost: (Auto)
- Total Amount Assigned: (Auto)
= Estimated Need: (Auto)

You will be asked to confirm that this is the project designation you want, as it cannot

be changed at a later time.

CONFIRMATION!

i

This project designation cannot be
changed later. Are you sure?

Because there is no Capital Code-Item-Center, and no designer/SCO design reviews, the
system assigns the Project Type of <$500K automatically.

Go to the ‘Contracts’ tab and select “Add Construction Contract.”

Program #: 12155 - State Construction Office - 2015-2016 Non-Code-ltem Projects
_Project #: 12287 - State Construction Office - Paint 4th floor spaces

Closeout Project |

Project Cost Estimate | Project Type | Funds Assigned

Financial Worksheet |

Milestones |

& Close

Contracts HUB Data |-~ P6 Link

SCO ID# FIRM

4

STATUS PHASE TYPE

PLAN REVIEW CONT!

0 found Add Construction Coniraci
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. . . . Search
At the Select Contractor search window, enter selection criteria and .
Select Contractor...
Name: [ [jka . Voice#: [ ke ¥ (999-999-9999)
Email: [ [jke ¥ > Fax# | ke ¥ (999-999-9999)
Status: | = ¥ || -select—- ¥ Website URL: | | e ¥
Contact Person: | je ¥ Year Established: | - v
Line1:| jke ¥
Line2:| ke ¥ Parent:| Lje W
City: | Like ¥ ParenI-Branch: - ¥ | -Select- ¥
state: [ g ¥ Minority Type: | = v | - Select — v
County: | = ¥ || —Select — v D ke ¥
Zip: | Like ¥ -
Last Update: | = v ;7
(o ) oo |
Click on the desired contractor from the list.
Select Contractor...
Name: | Like v |Pamt Voice#: | Like v (999-999-
Email: | | jke v 9999)
Status: | — v | _Select— v Fax#: | Like v (999-999-
Contact Person: | | ke v e e 9999)
ebsite L
Line 1:| Like v Like M
le? 2| Like M Year = v
City: | Like v Established:
State: | Like v Parent:| ke ¥
County: = Y | \WAKE v
.= Paren.t = ¥ | —-Select- ¥
Zip: | Like v Branch:
Minority Type: = Y | __Select — v
ID: | Like v
Last Update:| - v /7
(oo |
CONTRACTOR cITY COUNTY STATE  STATUS VOICE CONTACT
1 A and N Painting, LLC. Raleigh WAKE NC 973-478- AJ. Ware aand
2 Kenna Custom Painting Raleigh WAKE NC 919-855- Nancy Kenna kenn
3 Paintmaster LLC Wendell WAKE NC 919-365- Debra Eberhardt debr;
4 Production Painting Raleigh WAKE NC 919-676- Keisha Rochelle ene
5 Superior Painting Raleigh WAKE NC
6 Third Eye Painting Zebulon WAKE NC 919-404-
7 Tryon Hills Paint & Raleigh WAKE NC 919-779- Avinash Bhathela aving
8 WYNN BROTHERS RALEIGH WAKE NC 919-872-

1 page(s): [1]

The contractor information is displayed in the ‘Construction Contract Detail’ tab,
including HUB Type and Contract status. The Contract Status is set to “Creating” and the
default Contract Type is “General Contract.” Select an appropriate contract type if other
than “General.” Entering Owner Contact, Safety Officer, Surety, Sheets and Contractor
Contact is optional. Enter appropriate Award Details, Contract Date, and Contract

Action

Amounts. To avoid losing data, you can ™ as long as the status is “Creating.” When

69 [Rev. 7 —January 12, 2016]



InterscopePlus User Manual

all data is complete, change Contract Status to the appropriate “Valid” contract type and

k2 Action

H save

C ion Contract added

Program #: 10117 - St. Construction - Non-Code-item Projects
_Project # 11029 - St Construction - Paint 4th floor spaces
Construction Contract #: 15-11029-01A-1 - Production Painting Company

Construction Contract Detail HUB Participation HUB Good-Faith Efforts
LA Action 3 Close
Contract Summary Contractor Award Details
Formal Contract: N Award Type: Unknown
Name: Proguction Painting Company [
Contract Statusj{ Vald Informal ¥ Awarde:
Address: 3411 Garvey Drive, Suite 105
Contract Typet [ Painting Contract v Construction Start (NTF):
Raleigh, NC 27616
Licenses:
Contact:

Contract Dates.
Contract Date: 2015-04-01 g

HUB Type: B (Not Certified)

Owner Contact

Contract Amounts

Project Financial Worksheet Summary:

Surety Total Committed: $36,500
Name:
Worksheet Detail
Address:
Safety Officer
Contract Amounts:

Agent:

Amount  Days
Address:

Original: $36,500.00 45

Change Order: $0.00 0

Current: $36,500.00 ®

Enter Good Faith Efforts and additional HUB Participation as appropriate.

R. Closing a Project

Closing a project will allow it to be placed in an “Inactive” status, and by limiting searches to
“Active” projects, minimize the number of projects returned in searches. It is also beneficial to
close projects while all information and people involved are available and current.

1. Construction Closeout

Project closeout begins with the construction project. Once work is completed and the
contract documentation is being finalized, a contractor evaluation is required. That is
completed on the ‘Construction Contract’> ‘Evaluation’ tab.

Review and update HUB data on the ‘HUB Participation’ tab. Change HUB status to

“Finalization,” check the HUB Data is FINAL box and “** . Remember that current HUB

certification is checked and reported as of the data finalization so you will want to review data
carefully before finalizing. A beneficial occupancy date must be entered before HUB data can be
finalized.
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Program #:; 9809 - St. Construction - SCO office Builiding
_Project #: 10963 - St. Construction - SCO Office Project
__Design #: 15-10963-01 - SCO Designer

___Package: 15-10963-01A - SCO Office Project
____Construction Contract #: 15-10963-01A-1 - SCO Contractor
Construction Contract Detail Bid items HUB Good-Faith Efforts

HUB Participation Change Orders

Construction Contract HUB Participation

General Contractor: SCO Contractor

GC HUB Type: Not a HUB

EJEI Data is FINAL
Show HUB Details/Status as -
o Granaiy[=]

Contractor HUB Type HUB Cerfified?  CSIDivision Work

cClose
01

Current

2l Action

Lo D |

HUB Participation Summary (Certified O.—;

Awarded

Construction Contract Amount: $8,500,000.00 $8,500,000.00

Total HUB Participation: $0.00 $0.00

HUB %: 0.00 % 0.00 %

Awarded Current Contract PaymenisToDate  Final

Payment?

Go to the ‘Construction Contract Detail’ tab, change the Contract Status to “Complete,”

| sae
and K Delete

Program #: 8809 - St Construction - SCO office Buililding
_Project #: 10963 - St. Construction - SCO Office Project
__Design #: 15-10963-01 - SCO Designer

__ Package: 15-10963-01A - SCO Office Project

___ Construction Contract # 15-10963-01A-1 - SCO Contractor
Construction Contract Detail Bid tems HUB Good-Faith Efforts

HUB Participation Change Orders

Contract Summary Contractor

Formal Contract: Y Name: SCO Contractor [J

Contract Status: @ ~

Contract Type: General Contract -

Address: 301 N. Wilmington Street

Suite 450

Raleigh, NC 27601
Negotiation? N v
License#:
Bid Number: SCO-15-10963-01A
Contact:

HUB Type: Not a HUB

Owner Contact

2. Package Completion

-2 Action @ Close

Award %1 Delete

Approved Foi .

Award Details

Print Cover Letter
= e

C]
Construction Start (NTP): 02/03/2015 )]

Actual sia: U2/02/ 2015

Awarded: 02/05/2015

Contract Dates

Contract Date: 2015-02-09 @

Contracts Approved by Agency: o)

Contracts Approved by Atty @/‘
Genl:

Projected Completion: 2015-06-09 @

Contract Amounts

Select the ‘Package’> ‘Construction Contract Detail’ tab, change the Contract Status to

‘Complete” and *Te==

71

[Rev. 7 —January 12, 2016]



InterscopePlus User Manual

Program # 9808 - St. Construction - SCO office Builiiding
_Project # 10963 - St. Construction - SCO Office Project
__ Design #: 15-10363-01 - SCO Designer

__ Package: 15-10963-01A - SCO Office Project

Detail SCHEDULE - Planned and Actual Plan Reviews Construction Contracts Monthly Progress Weekly Inspection Electrical Certificates

21 Action & Close
Package A Bidding/Construction Contracts - @,

Oversight: Full Oversight Approved for Bid: Formal Contracts? Y x Delete
Title: SCO Office Project Approved for Award:  2015-02-05 Award Type: Sing
Type: Undetermined
Status: @ e Construction Administration Fees / Funds
Status Reaso;
Square Footag
Plan Location: Project Monitor: Unassigned Liquidated Damages (/day): $0
Menthly Conference: CD Cost Estimate: 50
Percent Complete: 0% @ Plan Deposit: $0.00
Total Change Orders: S0
County: UNKNOWN Final Punchlist: Y Total Construction Contract: S0

Description: SCO Office Project
Designer Rep:

Archive Information

Archive Date: / / (=]

Archive Box#:

3. Design Contract
Select the ‘Design’> ‘Evaluation’ tab, and complete designer evaluation.

|8 action

1 . Ny Al “« ” | save
Select the ‘Design’>‘Detail’ tab, change Contract Status to “Complete,” and .
Program #: 9808 - St Construction - SCO office Buililding
_Project #: 10963 - St. Construction - SCO Office Project
__Design #: 15-10963-01 - SCO Designer
Detail Contract Scope and Fees Breakdowns Amendments Consultants Packages
12 Action @Ciose
Contract# 1 Dates Design Contract Fees and Funds| save
Contract ID: 15-10963-01 selection: ) % peere
. ORIGINAL DESIGN CONTRACT:
SCO Oversight: Full Oversight RFP Letter: @
SCO Plan Review: Full Oversight Agreement: 2015-01-05 =) Construction Target §: 8,800,000 @
Signed By 2015-01-08 ) Contingency Reserve Target §: 270,000 @
Designer: = 3 D
signed By Agency: 2015-01-12 o) CHiginalDESIgnEEEs T
Contract Type: Standard Design Contract (Fully Funded)
B SCO Acceptance: 2015-01-12 7]
Contract status: @ - - CURRENT DESIGN CONTRACT:
S Construction Target: $8.800,000 @
Contingency Reserve Target: $270,000 @
R i g 800,000 @
Financial Worksheet Summary DesignlEes: € @
Designer Estimated:
Name: SCO Designer [ Assigned Funds: $10,000,000 Actual Commitment Amt $: $800.000.00
Address: 301 N. Wilmington Sireet Estimated Cost: $9.970,000
Suite 450 Estimated Surplus
MNeed): $30,000
Raleigh, NG 27601
Actual:
Licenset#: 123456789 ===
HUB Firm: Nota HUB Bssignedigundsy 10,000,000
Total Committed: $800,000
Available to Commit: $0.200,000

4. Contract Closeout
Select the ‘Project’>'Closeout Project’ tab. If the Steps 1 and 2 above were completed
correctly, all of the check boxes for “1 Contracts” should be checked.
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Program #: 9809 - St. Construction - SCO office Builiding
_Project #: 10963 - St. Construction - SCO Office Project

Project Cost Estimate Project Type Funds Assigned Financial Worksheet Contracts Milestones Cleseout Project

@Close
Close out Design / Construction
1 Contracts:

Contract CounterParty Contract For Status. Contract Closed  Ratings Present?  HUB Dala Finalized? Ready for Project
out? Closeout

15-10963-01 SCO Designer Design Complete
15-10963-01A-1 SCO Contractor Construction Complete

2 Milestones:

[] eertity that project milestone data is entered and complete.

3 Close Design / Construction for this project:

Close out Design / Construction

The check boxes report completed activities and cannot be manually checked. If they
are not checked, something was not completed in Steps 1, 2 or 3 above.

For “2 Milestones” check the box. Milestones include various key dates such as date of
award and notice to proceed that are entered throughout the system during the life of a
project. The Milestones tab summarizes key information. After completing the above,

Close out Design / Construction

Program #: 9809 - St. Construction - SCO office Builiiding
_Project #: 10963 - St. Construction - SCO Office Project

Project Cost Estimate Project Type Funds Assigned Financial Worksheet Contracts Milestones: Closeout Project
@close
Close out Design / Construction
1 Contracts:
Contract CounterParty Contract For Status Contract Clossd Out?  Ratings Fresent7 HU Data Fnaiized?  Resdy for Project
Closeout
15-10063-01  |SCO Designer Design Complete ¥4 v N/A v
15-10063.01A1 |SCO Contractor Consiruction Complete v v v v

2 Milestones:

ertify that project milestone data is entered and complete Certified by InterScope Administrator on 6/10/2015
3 Close Design / Construction for this project:

1 Close out Design / Construction ’
—

5. Financial Closeout

After the Design and Construction contracts have been closed, the next step is Financial
Closeout.
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Program #: 9809 - St Construction - SCO office Buililding
_Project # 10963 - St Construction - SCO Office Project

-~ Project | costEstmate | ProjectType | Funas Assioned | Financial Worksneet | Contracts |~ Milestones | Closeout Project
@ Close
Close out Design / Construction
1 Contracts:
Convaot CoumerPany Contraot For =™ Contrsct Closs_ Ratings Fresent?  WUB Dtz Ready for Froect
our Finsizes? Cleseout
151086301 | SCO Designer Design Complete. v v NIA v
15-10963014-1 | SCO Contractor Construction Complete: % v v v
2 Milestones:
I certfy that project milestone data is entered and complete GEME" by InterScope Administrator on ,WMBB
3 Close Design  Construction for this project:
Reopen Desigl ) Closed out by InterScope Administrator on mu/sz

Financial Closeout
1 Design/Construction closeout must be complete.
2 Allfunds assigned to this project must be committed or released:

Proiect Financial Worksheet Summary:
Assigned Funds: $10,000,000.00

Total Committed: §9,600,000.00

Available to Commit: EEI I Release Uncommitted Funds

Worksheet Detail

Close out Project Fil

In the Financial Closeout section is a summary of assigned funds, committed funds and
any available funds. To close out the project, the Available to Commit must be $0.
There are 2 options. The first option is to select the and let the system
“Un-assign” the funds, releasing them back to the Program. This is recommended if
there is only one fund source assigned to the project.

But, if there are multiple fund sources, navigate to the ‘Program’>’Assign Funds to
Projects’ tab and change the assignment amount to equal the committed amount, then

Action

5]

Save

This example illustrates multiple funding sources.

‘ Program #: 9903 - UNC Pembroke - Performing Arts School

Program | Pragram Funding | Projects | Assign Amounts to Projects Program Closeout |
[Z Action @ Close
Assign Funds to Projects
Source Authorization Tile  Current C-I-C Original C4-C Current Allacation Pending Changes Proposed Allocation Assignments
(Orig. + Appr.
Changes)
General Fund ~ Performing Arts  41531-301 41631-302 $ 600,00000$ -100,00000 $ 500,000 00 Froiect!D Project Name Agency  Assignment Amount
Building Project
Code
10921 |Parking ot $ 350,000 00 Delete
Add Assignment
State Debt Performing Arts  41531-301 41531-301 $ $ 000 ¢ | [gmisctiibioctbane 0oy Aosynent Mot
Building 30,000,000.00 30,000,000.00 E:JE"
e
10812 Purchase Land $| 1,750,000.00 Delete
Construct new
10913 ZEEMENSM $ [ 25,000,000 00 Delete
10921 Parking lot $| (50,000 Qa Delete
Extend camgus utilities $[ 1,750,000.00 Delete
- $1,450,00000 |

Add Assignment

2 Fund Assignment(s) found
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Return to the ‘Project’>’Closeout Project’ tab and the Available to Commit should equal

S0.

Program #: 9809 - St Construction - SCO office Builiiding
_Project #: 10963 - St Construction - SCO Office Project
Project |/ CostEstimate | ProjectType | Funds Assigned | Financial Worksheet | Contracts | Milestones |~ Closeout Project
@Close
Close out Design / Construction
1 Contracts:
Comsct CoumterRany Contract For Stans Coniaci Ciosed  Ratngs Fresen?  HUBDaia  Rescy for ot
o Finsioas? Clossout
15-10962-01  |SCO Designer Design Complete. v v NiA v
15108620141 [SCO Contractor Censtruction Complete 14 14 %4 %4
2 Wilestones:
| certiy that project milestone data is entered and complete Certifed by InterScope Administrator on 6/10/2015
3 Close Design | Construction for this project:
Reopen Design / Construction Closed out by InterScope Administrator on 6/10/2015
Financial Closeout
1 Design/ Construction closeout must be complete.
2 Allfunds assigned to this project must be committed or released:
Project Financial Worksheet Summary:
Assigned Funds: $9,600,000.00
Total Committed: $9,600,000.00
Available to Commit: 50.00
Waorksheet Detail
Close out Project Financials f . h . h . . I d
Select . After executing this, the project is closed.
Financial closeout successful.
Program #: 0800 - St Construction - SCO ofice Builiiding
_Project#:10963 - St Construction - SCO Office Project
Project | CostEstimate | Project Type Funds Assigned Financial Worksheet | Contracts | Milestones |~ Closeout Project
@Close
Close out Design / Construction
1 Contracts:
Contsst  CoumterPany Gonrast For Soaes Contract Closed  Ratigs Fresent?  HUBData  Ready for Projet
our Finsiasa? Closeon
151096301 | SCO Designer Design Complete v v NIA v
15-10963-01A1 | SCO Contractor Construction Compiete %4 4 v v
2 Milestones:
I certiy that project milestone data is entersd and complete Certiied by interScope Administrator on 610/2015
3 Close Design / Construction for this project:
Reopen Design / Construcion Closed out by interScope Administrator on 6/10/2015
Financial Closeout
1 Design | Construction closeout must be complete.
2 All funds assigned to this project must be committed or released:
Project Financial Worksheet Summary:
Assigned Funds: $9,600,000.00
Total Committed: $9,600,000.00
Available to Commit: 50.00
Worksheet Detail
Reopen Project Fin @ssu out by InterScope Administrator on Eﬂﬂllll@

S. Closing a Program

Closing a Program is similar to closing Projects. To close a program, all projects must be closed,

there can be no pending transfers, and there cannot be any unassigned funds. Funds cannot be
assigned to closed projects, so any funds remaining in the program must be transferred to other
Programs or the allocation from the Authorization must be reduced. Community Colleges and
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Universities should utilize the Funds Transfer function to request movement of funds or
increase/decrease in authority. Permission to close programs will be established at the same
levels as they were created. For the universities and community colleges programs will be
closed by UNC GA or NCCCS System Office.

Program #: 9809 - 5t. Construction - SCO office Buililding

Prugram] F’rugramFundmgI Pro]e:lsl .Asslgn.AmounlstuPro]e:lsI Program Closeout
@Ciose

Close out Projects

1. Projects:
Project D Tite Project Status Ready for Program
Closeout
10963 SCO Office Project Financials Closed Qut

Close out Financials

2. There may not be any pending Funds Transfer or Increase / Decrease Authorization requests that affect this program.

3. All funds allocated to this program must be assigned, transferred or released.

Source. Current GG Oniginai G-1-C. Orginal Allocated Amt Panding Changes Current Allocated Amt Assigned To Projacts Avaitzbis To Assign
State Debt 41501-4T01 41501-4T01 £9,600,000.00, 50.00 £9,600,000.00, $9,600,000.00 50

Once the Available to Assign funds is S0, click the BESSEEEES

Program closeout successful. The status of the program has been changed to Complefe.
Program #: 9809 - St Construcion - SCO office Buililding
Program |~ Program Funaing |~ Prajects |~ Assign Amounts to Projects | Program Closeout
@cClose
Close out Projects
1. Projects:
Prowet 1D Tl Proect Status Ready for Program
Gossout
10963 SCO Office Project Financials Clesed Out v

Close out Financials
2. There may not be any pending Funds Transfer or Increase | Decrease Authorization requests that affect this program.
3. All funds allocated to this program must be assigned, transferred of released.

Source [ Grgnal T1C Original Atoated Amt Pending Ghanges Gurent Alocated Armt Assiged To Proests Avaiatte To Assign

State Debt 41501-4T01 41501-4T01 '$9,600,000.00 $0.00 '$9,600,000.00| '$9,600,000.00| $0.00

Reopen Program @Oseﬂouf by InterScope Administrator on 6/10/2015,
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VI.

Advanced Functions

A. Funds Change Request

Funds change requests allow moving funds from an Authorization/Program to another
Authorization/ Program. It begins with entering a request, and continues with a sequential
multi-step approval process.

A separate request must be created for each source of funds to be transferred.

The Program that the funds will be transferred from must have unassigned funds equal to or
greater than the amount to be transferred within the source of funds to be transferred, i.e. the
program must have $15,000 unassighed Non-General Fund (NGF) funds in order to be able to
transfer $15,000 NGF. Excess funds in projects may be unassigned to increase the amount of
unassigned funds available within a program.

At the top of your home page, select Funds Change Request>Funds Change Request to bring up
the Funds Transfer Search Screen.

USER: Mrfixit71
fat Home %/ New ('l‘\. FcAaP 4 Design Review $ Authorizations G Programs Funds Change Request ‘ 5 My Account % Reports @ Help
i ’_@;ﬂ;! Request Search
System Nofices My Favorites Active Design Contracts Active Consfruction Contrac | g q Projects New Projects
TYPE FAVORITE Delets?

On the search screen, you can search for a previous request that has been made to check the
status or create a new request. A new request may be either a transfer of existing funds from
one program to another or an increase/decrease in authority. Increase/decrease in authority
applies generally to Non-General Fund or Non-State Debt funding sources where the
agency/institution is providing the funds, or releasing unneeded funds. Both follow a similar
approval process.

13 InterSCOPE :: State Of North Carolina - State Construction
|

USER: Mrfixit71

fa Home % New C*}. FCAP C*}. Design Review $ Authorizations GPrograms Funds Change Request 85 My Account % Reports @ Help

Funds Transfers Search: Enter criteria and press search

Department: | = v Request Status: - ¥ Select Status — ¥
- Select Department -—- v Budget Code: | Like v
Institution/Agency: | _ v | __Select Agency — ¥ Budget Item: | | ke v
Fiscal Year:| - ¥ | - SelectFiscal Year — ¥ neasicetesl Like v
Change Amount: - v
Request Type: - ¥ | Select Transfer Type — ¥
m m New Funds Transfer tew Increase/Decrease
1. Funds Transfer

Select the New Funds Transfer button. Search for the Program that you want to transfer
the funds from and select the desired program. Enter the amount you wish to transfer.
If there are multiple fund sources in the program, be sure to select the desired fund
source. Then, search for and select the Program to which you will transfer the funds.
Enter appropriate remarks as to why you are transferring the funds. Then | conine |,
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FUNDS TRANSFER

Ziaction @Close

Transfer From:
Agency: UNC Pembroke

Program: [Performing Arts School (3303) ] -
Source Of Funds |  Codeltem Center | Originol CodeTtem | Alocated Amount | Assigned To Projects | Pending Changes | Avallable To Assign | Transfer Amount
SD 41531-301 41531-301 $30,000,000.00  $30,000,000.00 $0.00 50-0'1 $0.00
GF 41531-301 41631-302 $600,000.00 $350,000.00 $0.00 $250,000.00 190000

Total Amount to Transfer: $0.00

Transfer To:
Agency: UNC Pembroke
Program: Agricuttural Center (9904)
Authorization: | 2017 - 41631-302-Agricultural Center v |
Remarks:

Move utility work to Progran|

This brings up the summary of the request, above. Select “=*  and you will see the
workflow with the current status as shown on page 74 following submission. This also
creates a “Pending Change” for the Authorization and Program financials shown below.

_Authorization #: 97 - UNC Pembroke - Performing Arts Building
Authorization

- @Close
Authorization Information Funding Information
Department: Educational Institutions (Universities) Budget Code: 41531
Budget Item: 301
NCAS Center:
Agency Funding Code:
Authorized Date: 1/21/2015
Legislative Authorization: Yes ) Total Authorized: $30,000,000.00
Authorized Purpose: Construct new school for Performing Arts
Is From Capstat: False

Authorization Item Summary  Authorization Item Detail |  Program Allocation liem Audit Trail Uploads  |” Comments |

Source orig. €1 Oviginal Authorized Amaunt  Approved Changes | Pending Changes posed Authorization Amount Curent Allocated Amount  Assigned To Projects  Available To Assign

1 General Fund 41531-301 $0.00 $600,000.00 $-100,000.00 $500,000.00 $600,000.00 $350,000.00 $150,000.00
2 Mon-General Fund  41531-301 $0.00 $0.00 5 $0.00 $0.00 30.00 $0.00
3 Mon-State Debt 41531301 $0.00 50.00 $0.00 $0.00 $0.00 $0.00 50.00
4 RER General Fund 41531-301 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00
s RER State Debt 41531-301 $0.00 50.00 $0.00 $0.00 50.00 $0.00 50.00
6 State Debt 41531301 30,000,000.00 50.00 $0.00 $30,000,000.00 $30,000,000.00  $30,000,000.00 50.00

($100,000.00)

_Authorization #: 97 - UNC Pembroke - Performing Arts Building
Authorization

- @Close
Authorization Information Funding Information
Department: Educational Institutions (Universities) Budget Code: 41531
H Budget Item: 301
NCAS Center:
Agency Funding Code:
Authorized Date: 1/21/2015
Legislative Authorization: Yes v/ Total Authorized: $30,000,000.00
Authorized Purpose: Construct new school for Performing Arts
Is From Capstat: False

Authorization ltem Summary | Authorization Item Detail Program Allocation | Authorization ltem Audit Trail Uploads | Comments |
Source Onig CIC Current Authorization

Pending Changes ) Available To Allocate Allocations

(©rig + Appr Changes)
41531-301 $ 0.00] $ 0.00 $ 0.00;
141631302 $ 600,00000 \ 3 -100,000.00) $ 500,000.00| [Program Agency Program Name Original Allocated Avaiable to to Projects
(General Fund D Amount
& JUNC Pembroke Performing Arts School| $000 $600.000.00 $ 000.00 ) $500,00000 § 350.000.00
Allocation Count: 1 To Allocate 7 .
Non-General Fund 41531-301 $ 000 $ 0.00 $ 000
Non-State Debt 41531301 $ 000 $ 000 $ 000
R&R General Fund 41531-301 $ 000 $ 000 $ 000
R&R State Debt  41531-301 $ 000 $ 0.00 $ 000
State Debt 41531301 $ 30,000,000.00 $000 § 30,000,000.00 [Program agency Program Name Original Allocated Approved Ghanges Pening Chianges  Availabe 1o Assign Assigned to Projects
D Amount
9903  JUNC Pembroke W $30,000,000.00 $000 $0.00 $ 30,000,000.00 $ 30,000,000.00
Allocation Count: 1 [To Allocate $0.00

. R S

Select to send the request forward for approval.
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Funds Transfer Summary Funds Transfer

Institution / Agency: UNC Pembroke
Amount: $100,000.00

Effect on Source Authorization: 41531-301 Performing Arts Building
Authorized Funds

Effect on Source Program: 9903 - Performing Aris School
Funds Allocated to Program

Transaction:
Remarks:
Effect on

[&# workfiow Ziaction

Move utility work to Prograr
41631-302 Agricultural Center

@Close

Authorized Funds

Effect on Destination Program: 9904 - Agricultural Center
Funds Allocated To Program

r L7 Workflow
step AcTION AcTvE? roLE ORGANEZATION APPROVER coMpLETED O ALERTED O oIsposITION commEnTs
1 cReATE N AGENCY UNC Pembroke 4/13/2015 Created reox
2 SuBMIT v AGENCY UNC Pembroke
APPROVE N AGENCY UNC Pembroke
4 APPROVE N DEPARTMENT Educational Institutions (Universities)
5 APPROVE N 0sBM State Budget And Management
Comments

Normally, the requester will not be approving the request for the Agency/Institution,
but an email will be sent to the Approver, notifying him/her that there is a request for

his/her action.

Funds Transfer Summary Funds Transfer

Institution / Agency: UNC Pembroke
Amount: $100.000.00

Effect on Source Authorization: 2017 - 41531-302 - Agricultural Center
Authorized Funds

Effect on Source Program: 9904 - Agricultural Center
Funds Allocated to Program

Transaction:
Remarks:

@ cClose

Transfer Funds

Shit utilty work to this project

Effect on Destination Authorization: 41531:301 Performing Arts Building
Authorized Funds

Effect on Destination Program: 9903 - Performing Arts School

Funds Allocated To Program

[ Worktow
se AcTion acTver RoLe oRGANIZATION ApPROVER CompLETED O ALERTED ON DisPosITION commenTs
1 CREATE N AGENCY UNC Pembroke 4/13/2015 Created reox
2 susMIT N AGENCY UNC Pembroke 4/13/2015 pending reox
3 APPROVE Y AGENCY UNC Pembroke
4 APPROVE N DEPARTMENT  Educational Institutions (Universities)
5  APPROVE N 0SBM State Budget And Management
Comments

The person who is the next level up in the approval process will open the transaction
and make a decision to accept or reject the request, by selecting the appropriate

l@ 'Workflow |
i

@~ | Approve

53 Reject

button under Workflow. They may make comments in the space provided at

the bottom of the workflow, and an explanation in the comments is mandatory if they

Reject the request.

If that person disapproves the request, the original requester is notified and the process
is complete. If that person approves the request, the system notifies the next higher

level approver.

The 3™ level person must log in and navigate to the pending request.

Funds Transfer Summary. Funds Transfer

Institution / Agency: UNC Pembroke
Amount: $100,000.00

Effect on Source Authorization: 41631-302 Agriculiural Center
Authorized Funds

Effect on Source Program: 9904 - Agricultural Center
Funds Allocated to Program

Transaction:
Remarks:

& Workflow

QClose

Transfer Funds
Shift utility work to this project.

Effect on Destination Authorization: 41531:301 Performing Arts Building
Authorized Funds

Effect on Destination Program: 9903 - Performing Arts School

Funds Allocated To Program

|— 57 Workflow
s AcTIoN AcTvE? ROLE ORGANIZATION APPROVER COMPLETED ot ALERTED of DISPOSITION COMMENTS
1 CREATE N AGENCY UNC Pembroke 4/13/2015 Created rcox
2 susMIT N AGENCY UNC Pembroke 4/13/2015 Pending reox
3 APPROVE N AGENCY UNC Pembroke 4/13/2015 Pending reox
4 APPROVE Y DEPARTMENT Educational Institutions (Universities)
5 APPROVE N 0OSBM State Budget And Management
Comments
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They have the option of approving or disapproving the request using the . ©=

l@ 'Workflow |
i

@ Approve

, and

making comments. If they disapprove, the requester and Agency approver are notified
and the process is complete. If they approve, the request goes forward to the next

level.

Funds Transfer Summary Funds Transfer

UNC Pembroke
$100,000.00

Institution / Agency:
Amount:

Effect on Source Authorization: 2017 - 41631-302 - Agricultural Center

Authorized Funds

Effect on Source Program: 9904 - Agricultural Center

Funds Allocated to Program

4 workfiow

@Close

Transaction: Transfer Funds

Remarks: Shift utility work to this project.
Effect on Destination Autherization: 41531-301 Performing Arts Building
Authorized Funds

Effect on Destination Program: 9903 - Performing Arts School
Funds Allocated To Program

[ 7 Workflow
e acrion Acrmver roue oRsANIZATION semroven CompieTeD on P oispostTion comvents
1 CREATE N AGENCY UNC Pembroke 4/13/2015 Created reox
2 SUBMIT N AGENCY UNC Pembroke 4/13/2015 Pending rcox
3 APPROVE N AGENCY UNC Pembroke 4/13/2015 Pending rcox
4 APPROVE N DEPARTMENT Educational Institutions (Universities) 4/13/2015 Pending uncga
5 APPROVE Y 0sBM State Budget And Management.
‘Comments

The status for the request remains in “Pending” until disapproved, or until the top level
of the approval process approves it.

Funds Transfer Summary Funds Transfer

@cClose

Transaction: Transfer Funds
Remarks: Shift utiity work to this project
Effect on Destination Authorization: 41531-301 Performing Aris Building
Authorized Funds

Institution / Agency: UNC Pembroke
Amount: $100,000.00

Effect on Source Authorization: 41631-302 Agricultural Center
Authorized Funds

Effect on Source Program: 9304 - Agricultural Center
Funds Allocated to Program

Effect on Destination Program: 3303 - Performing Arts School
Funds Allocated To Program

|—\_’7’ Workflow
srep acion scver ot onoazATION reprovER conpLETeD on sTED ON em— comvens
1 CREATE N AGENCY UNC Pembroke 4/13/2015 Created rcox
2 SuBMIT N AGENCY UNC Pembroke 4/13/2015 Pending rcox
3 APPROVE N AGENCY UNC Pembroke 4/13/2015 Pending rcox
4 APPROVE N DEPARTMENT Educational Institutions (Universities) 4/13/2015 Pending uncga
5 APPROVE N 0sBM State Budget And Management 4/13/2015 Approved osbm
Comments

Once it receives final approval, the funds records will be updated and there will no
longer be funds in a pending status. While funds are in a pending status, they may not
be assigned, committed, or otherwise affected.

2. Increase/Decrease
To request an increase or decrease in funds, select the New Increase/Decrease button.

Inter SCOPE :: State Of North Carolina - State Construction
Office

VIEW: Educational Institutions (Universities)

fiHome || companies “JNew % Authorizations [lPrograms B3 Funds Transter [SdMy Account @ Help
Funds Transfers Search: Enter criteria and press search

Department: | = v Request Status: | = ¥ | — Select Status —- ¥

Educational Institutions (Universities) A Budget Code: | (ke ¥

Institution/Agency: | _ ¥ | — Select Agency — v Budget Item: | | jke v

Fiscal Year: | = ¥ | —Select Fiscal Year— ¥ N | U= Y

Change Amount: | - v
Request Type: | = ¥ | — Select Transfer Type — ¥

[scaen [ o [ rest ]| nevrncs vt | v oo |
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B.

NOTE: You may only increase or decrease existing authority.

Search for and select the authorization you wish to increase. Enter amount and
remarks, then [_contine |,

Authorization Change

@Close
Increase or Decrease Authority
Existing Authorization: Total Authorized:

Orginal C1.C Currant C1C Soues Original Auth At | Approved Changes | Pancing Changss | CurmentAuth Amt | Proposed Changs Propossd Totsl
41631-313 41631-313 sD o o 0 $0.00 $0.00
41631-313 41631313 NSD 0 0 0 $0.00 50.00
41631-313 GF 0 0 o) $0.00 $0.00,
41631313 NGF 50000 0 50000 10000 $60,000.00
41631-313 RRGF o 0 0 $0.00 $0.00
41631313 RRSD o 0 0 $0.00 50.00

Total Change in Authority: $10,000.00
Allocate To Program
Program: | Agricuttural Center (9904) v
Remarks: |5;,pnlement for increased cost
Continue:
A acton

This brings up the summary of the request. Select “**  and you will see the workflow

with the current status. Select to send the request forward for approval.

Authorization Change
& Workflow |-Z Action @Close
-w-.

Institution / Agency:  UNC Pembroke Transaction: Increase/Decrease

Amount: $10,000.00 Remarks: Supplement for increased cost
Effect on i 2017 - 41631:313 - Ag Center NGF Effect on Program: 9904 - Agricultural Center
Authorized Funds Funds Allocated to Program

|'_fwum||uw

E=Y ACTION P RoLE ORGANIZATION APPROVER COMPLETED ON ALERTED ON DISPOSITION COMMENTS
1 CREATE N AGENCY UNC Pembroke 4/13/2015 Created reox
2 SUBMIT Y AGENCY UNC Pembroke
APPROVE N AGENCY UNC Pembroke
4 APPROVE N DEPARTMENT  Educational Institutions (Universities)
5 APPROVE N osBM State Budget And Management
Comments

The workflow continues the same as a funds transfer request until it is approved or
rejected.

Primavera (P6) Linking to Interscope

Primavera schedules are required for Standard Projects over $500K and are optional for smaller
projects. Projects <$500K that are funded by R&R State Debt may be required to have
schedules if OSBM or the State Treasurer require cash flow forecasting.

The P6 schedule is a planning tool for managing the project schedule and forecasting when
milestones will occur. In general, milestone dates from P6 will be uploaded into Interscope as
“Planned” dates and “Actual” dates will be entered in Interscope and automatically be
downloaded into P6.

A schedule must exist in P6 to be able to link it to Interscope. It is recommended that the
Project ID in P6 be the same as the Project ID in Interscope for ease of linking.
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1. Establishing the Link
Select the Project>P6 Link tab, select the box that says “Link Project Milestones to P6

Schedule,” and select the project from the dropdown project list.

Program #: 11679 - East Carolina University - [41136-306] - New Student Union & Health Sciences Student Service Building

_Project #: 9263 - East Carolina University - Main Campus Student Union & Parking Deck

Project Cost Estimate Project Type Funds Assigned Financial Worksheet Contracts P6 Link Milestones Closeout Project Evaluations.
[Z Action @close
Project ID: 9263
Project Title: Main Campus Student Union & Parking Deck
@ Project Milestones to P§ Schedule?
P6 Project: -- Select a P6 Project -- v

Uploads Comi

Delets? DATE

2014-12-02 14:21)]

12/1/20157:14:47 AM  Inters|

- Select a P6 Project -
+ - Wright Circle - Mill and Repave

HSC Student Services Bldg
10401 - 2013 R&R - Replace Sectionalizing Switches 23, 24, 29
10488 - Replacement Condensate Electrical Utilities at Greenmill Run (Single Prime)
10492 - North Recreation Complex Phase 3
11182 - Aycock Basement (Single Prime)
40000-10 - Guaranteed Energy Savings Performance Contracting
40000-22 - Service Learning Center - CSLC #10 (Single Prime)

Auto-Map Milestones

DESCRIPTION

Pre-Con CMR s

»

Delete Selected Files I Upload Files
Department of Administration - State Construction Office |Report a Problem

40000-29 - Brody - GE-99 (Single Prime)

40000-43 - Service Learning Center - CSLC #3 (Single Prime)
40136-2 - Craft Lab

40436-3 - Coastal Studies Revised Site (CM at Risk) COPS
40436-307 - Coastal Studies Revised Site (CM at Risk) COPS
40483-2 - Eastemn Carolina Cardiovascular Institute

40536-2 - Residence Hall HYAC Improvements (Cotten)

40536-303A - BSOM-Family Medicine Center Bldg. (Single Prime) &
2. Select the Auto-Map Milestones to have the program match as many
Action
] save

milestones as possible without user intervention. Then
individual Milestones.

As with other data fields in Interscope, milestone dates are related to the various parts
of the project i.e. the designer contract milestone date is found in the design contract
section, the construction contract milestone date is found in the construction contract
section, etc. There are Milestone tabs at the project level, design contract level,
package level and construction contract level. Where there are multiple contracts,
ensure that the milestone is linked to the proper contract i.e. the commissioning
authority contract milestone has to be linked to the design contract for the
commissioning authority, and the pre-con contract milestone to the pre-con contract.

.Mapping

Select the Project>Milestones tab

Program #: 11679 - East Carolina University - [41136-306] - New Student Union & Health Sciences Student Service Building
_Project #: 9263 - East Carolina University - Main Campus Student Union & Parking Deck

Project Cost Estimate Project Type Funds Assigned Financial Worksheet Contracts P6 Link Milestones Closeout Project Evaluations

[ Action ©Close

Milestones For: Project #: 9263 - East Carolina University - Main Campus Student Union & Parking Deck

09263 - Student Union (CM at Risk)

Note: Red border indicates a required milestone
P6 Project:

Project Milestones

Code PG Code Name P8 Activity P& Activity Name Change PG Activity Planned Actual
DESADVPRJ DESADVPRJ Date of FIRST advertisement for designer @Imk /7
GXADVPRJ GCXADVPRJ Slifo::‘dve"‘seme”t for commissioning g0 IAdvertise for Commissioning Agent change wnlink 31912015 // E
CXCONPRJ CXCONPRJ Execute Commissioning Contract A3000 Cx Contract Milestone change unlink 7112014 /7 @
CLOSEPRJ CLOSEPRJ Project Closeout A2530 Construction Closeout Milestone change unlink 71512018

CMADVPRJ CMADVPRJ Advertise for CM at Risk A2850 Advertise for CMAR Milestone change unlink 3/6/2015 /o
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VILI.

In this case, the Designer Advertisement milestone did not map. Select ‘change’ for that activity

Action

and pick the activity from the dropdown list, then = =

Program #: 11679 - East Carolina University - [41136-306] - New Student Union & Health Sciences Student Service Building
_Project #: 9263 - Fast Carolina Universifv - Main Camnus Student nion & Parkina Deck

. P6 Activity :
Project qg Evaluations |
Milestone Name: Date of FIRST advertisement for designer @Close

5 Code: DESADVPRJ . ;

Milestones For: equired milestone
. P6 Project: 09263 - Student Union (CM at Risk)
P6 Project:
P6 Code: DESADVPRJ
Project Mileston
(Code tual
DESADVPRJ
CXADVPRJ Select Activity ID Activity Description Mstn Code Planned Actual
CXCONPRY SELECT))  At000 Advertise for Designer Milestone DESADVPR] 11/17/2011  11/17/2011 &
T
e — iELELT A1040 Designer Selected Milestone DESSELDC  2/27/2012 2/27/2012
SELECT 090 ! I 4/20 4/20
CMADVPRY A109 Design Contract Milestone DESCONDC = 9/4/2012 9/4/2012
_ SELECT A1120 Programming submittal to SCO APSSCOPKG  8/31/2015 5/30/2013
| SELECT A1130 Programming submittal approval by SCO APASCOPKG 8/31/2015 6/18/2013
1 456

Uploads Epage(s) (1122456 Go

Delete? N

(=] N4 ¥

It is now linked and shows the planned advertisement date.

Program #: 11679 - East Carolina University - [41136-306] - New Student Union & Health Sciences Student Service Building
_Project #: 9263 - East Carolina University - Main Campus Student Union & Parking Deck

Project Cost Estimate Project Type Funds Assigned Financial Worksheet Contracts P6 Link Milestones Closeout Project Evaluations
[Z Action Close
Milestones For: Project #: 9263 - East Carolina University - Main Campus Student Union & Parking Deck Note: Red border indicates a required milestone
P6 Project: 09263 - Student Union (CM at Risk)

Project Milestones

Code PE Code Name PB Activit P6 Activity Name Change P Activity Planned Actual
DESADVPRJ ~ DESADVPRJ  Date of FIRST advertisement for designer guou Advertise for Designer Milestone j change unlink /7
CXADVPRJ CXADVPRJ Sj;ﬁocr‘lftyadve"‘ser“e”‘ for commissioning | 5539 Advertise for Commissioning Agent change unlink 3/9/2015 /7
CXCONPRJ  CXCONPRJ  [Execute Commissioning Contract /A3000 Cx Contract Milestone change unlink 7/1/2014 /7
CLOSEPRJ CLOSEPRJ Project Closeout A2530 Construction Closeout Milestone change unlink 7/5/2018

CMADVPRJ  CMADVPRJ  Advertise for CM at Risk 2850 Advertise for CMAR Milestone change unlink 3/6/2015 /7

The linking process should be continued until all applicable milestones are linked. Not all
Interscope milestones are in the P6 schedule. Not all P6 milestones apply to every project, as
not every project has commissioning, or utilizes CM delivery. The milestones highlighted in gray
should be in all P6 schedules. The required milestones must be linked and cannot be unlinked.

As the project progresses, actual dates are entered in Interscope, either by SCO for full oversight
projects, or by agency/institution for other projects. Those actual dates are then downloaded
into the P6 linked activity.

Reporting

From the Home screen, select Reports> Global and Institutional Reports.

InterSCOPE :: State Of North Carolina - State Construction

‘Office
far Home

E New (\ FCAP ';\ Design Review $ Authorizations Q Programs Funds Change Request 85 My Account

Program #: 12153 - State Construction Office - Minor Renovations "€ Global and Institutional Repo
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This will bring up a new screen with two tabs — Global Reports and Institutional Reports. In
general, Global reports are available to owners (state employees) and contain information that
would be of interest to users across all departments and agencies. Institutional Reports are
available to owners but the data that can be retrieved with the report is limited to their
respective agency/institution.
Global Reports Institutional Reports
Reports will appear in a new tab. Please disable any popup blockers for this site.

HUB Reports

HUB Participation Annual Summary

Design Contracts

Designer Selections

Construction Contracts

Capital Improvement Reports

Capital Improvements Projects

NOTE: You must disable pop-up blockers
for this sight in order to see the reports.

Select the desired report and it will appear in a new tab on your browser using the default
criteria. The report may be filtered by selecting parameters from the sidebar. After selecting
any parameters, click on “View Report” to see the new report. The selection parameters are
shown in the report heading.

Export to PDF Export to Excel Export to Word Document Export to HTML Document Export to Image

E # Page [1774
Department D
- Dasi Select
Administration vy — gheratreciiuns Agency: ALL
Agency Project Status: ALL
AL e //
Project Status
ALL ¥ 1
few report J)
— Projects Less than $2M
Estimated Designer
Agency Program Narme project D | Project Title “Total Cost | Desiener Name Design Fee| 0 o0
Administraton General Revenus Buiding Eevater 4277 | Revenue Buiding Elevator solf anD architects, p.a. so| os/o2/z000
Installaticn nstallation
Administreton General Watson House Accessibil ty 4431 [ Watson House Accessibilty solf .. annis, Architect, Al so| 10/23/2000
Modifications Modifications
“ Admiristration General ‘m::zr Building Elzvator Lpgracs;” 2223 “C:cpe' Building Elevator J:g'idzsl snu The Wooten Company I 583 s:s“ 11/15/2000 |
Administration General New Juvenile Youth Development 5544 Youth Development 50][ 0 Brien / Atkins Associates, P.A 597,956 04/16/2003
Centers (YDC
©'Brien / Atkins Associates, P.A $5,171,038| 09/23/2004
Administration General Garner Rd Complex — Facility & 5825 | Garner Rd Complex - Facilty & 50| united Engineering Group, Inc. {Inaive; sof 11/15/2008
Utility Upgrades Utility Upgrades
Designer Selections Report Generated: 5/28/2015 1.28:16 PM Page 10f 101

The report may be exported to a pdf document, Excel, a word (.rtf) document, an HTML
document, or to an image (.tiff).
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VIII.

If you want to search for a particular word or phrase, select binoculars
the sidebar and it will bring up the search information.

To return to the parameters, click on the |

at the bottom of

Expo

What word or phrase would
you like search for?

Use these additional criteria:
L Whole words only

Interscope
[ Match case
Find results:
Projects Less than $2M
Agency
Appalachian state Univer
Search || Clear Appalachian State Univer
Appalachian state Univer

Problem Reporting/ User Feedback/Help

A.

Problem Reporting
The system has a tool for reporting problems that can be found at the bottom of each screen
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Program #: 12155 - State Construction Office - 2015-2016 Non-Code-ltem Projects
_Project #: 12287 - State Construction Office - Paint 4th floor spaces

Closeout Project |
|

Project Cost Estimate | Project Type | Funds Assigned Financial Worksheet | Contracts HUB Data | P6 Link Milestones
B Close
SCO ID¥ FIRM STATUS PHASE TYPE PLAN REVIEW CONT|
{ »
ound Add Construction Coniract
Uploads Comments | Project Managers |
Delete? DATE = TYPE FILE NAME DESCRIPTION

Upload Files

10/7/2015 9:44:59 AM InterscopePlus 1.3C_TRAIN Copyright © 2015 - State of North Carolina : Department of Administration : State Construction Office eport a Problem

When a problem is encountered, click the button and the system will automatically capture a

Action
. . -IH|Save —
screen shot. Enter a the requested informationand = .

ADD PROBLEM REPORT

Problem Report
2l Action @Close

Problem
Report#:
Component: ProgramDetail
User: scoadmin

The system has recorded a screen capture of the problem.
Please enter a detailed description of the problem including the steps needed to
reproduce it.
Include any additional contact information and use the Action menu to Save your
report
The Interscope Administrator will be alerted and follow up for resolution.

(auto)

Description:

B. Contact
The system administrator may be contacted by clicking on the “CONTACT ADMINISTRATOR” link

on the logon page.
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IX.  Evaluations
Please view the designer and contractors evaluations manual for assistance with performing

evaluations.
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